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Лабораторная работа № 1 

Аппаратные и программные средства отладки eZDSP F2812 и  

Code Composer Studio 

 

Цель работы: ознакомиться с аппаратной и программной ча-
стью лабораторного оборудования, научиться создавать и отлаживать 

простейшие программы для цифрового сигнального процессора 
TMS320F2812. 

 

Теоретические сведения 

 

Аппаратная часть стенда состоит из платы эмулятора и платы 

расширения, а программная – из среды разработки Code Composer 

Studio.  

На рис. 1.1 представлена плата эмулятора eZDSP320F2812 c 

платой расширения. На плате эмулятора размещен сигнальный про-

цессор TMS320F2812 и схема, обеспечивающая его работу – стабили-

затор напряжения (+3.3В для периферии и +1.9В для ядра), схема 
JTAG-эмулятора, внешнее ОЗУ. Плата эмулятора соединена с платой 

расширения Zwickau Adapterboard, расположенной под ней (рис. 1.1). 

На плате расширения располагаются светодиоды, переключатели, 

кнопки, потенциометры, ЦАП, микросхема FLASH-памяти, датчик 

температуры, микросхемы интерфейсов RS-232 и CAN, звуковой пье-
зоэлектрический преобразователь. Связь эмулятора и ПЭВМ осуще-
ствляется через LPT-порт.  

Code Composer Studio (CCS) – интегрированная среда разработ-
ки для цифровых сигнальных процессоров фирмы Texas Instruments. 
После загрузки программы открывается окно, разделенное на две вер-
тикальные части. В левой части (узкой) отображается окно проекта, в 
правой (широкой) – рабочая область (рис. 1.2). Любой проект 
(Project), кроме файла с выполняемой программой на языке Си или 
Ассемблер, содержит  командные файлы, библиотеки, линкеры. Дан-
ные файлы необходимы для преобразования исходного текста про-
грамм в машинный код, который затем загружается в процессор. 
Файл управления линкером сопоставляет логические сектора (область 
данных, программ) и физическую память сигнального процессора.  
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Рис. 1.1. Плата эмулятора eZDSP и плата расширения Zwickau 

Adapterboard 

 

  
 

Рис. 1.2. Вид рабочего окна Code Composer Studio 
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Процедура линковки объединяет один и более объектные файлы 
(*.obj) в выходной файл (*.out), который содержит машинные коды, 
адреса и отладочную информацию. Проект может содержать более 
одного файла программ и подпрограмм, причем допускается написа-
ние программ и их частей на различных языках (Си, Си++, Макроас-
семблер). Все это позволяет максимально эффективно использовать 
имеющиеся наработки в последующих проектах. Несколько проектов 
могут объединяться в рабочей области, но компилироваться и отла-
живаться будет только один – текущий проект. При выполнении ла-
бораторных работ не рекомендуется открывать сразу несколько про-
ектов. 

 

Ход работы 

 

1. Создание нового проекта. 
Через вкладку меню Project → New создаем новый проект. В по-

ле Project Name записываем название проекта «Lab1». В поле Location 

указывается путь, по которому будет находиться проект – 

E:\DspUser\Lab1. В поле Project Type выбираем Executable (.out), а в 

поле Target – TMS320C28XX. В случае если плата эмулятора про-

граммно не подключена к ПЭВМ, осуществляем подключение через  
вкладку меню Debug → Connect. 

 

2. Создание файла программы.  

Через вкладку меню File → New → Sourse File создаем файл. 

Содержимое файла отображается в рабочей области программы. Да-
лее заносим (копируем) в него тестовую программу, представленную 

на рис. 1.3. Затем необходимо сохранить в папке для проекта, вы-

бранной в п. 1, написанную программу под именем «lab1.c» через 
вкладку меню File → Save as: «lab1.c». 

 
unsigned int k; 
void main (void) 
{ 
unsigned int i; 
while(1) 
{ 
for (i=0;i<100;i++) 
k=i*i; 
} 
} 

Рис. 1.3. Тестовая программа 
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3. Добавление файлов в проект. 
Сохраненный файл еще не является частью проекта и при ком-

пиляции проекта не будет учтен. Его необходимо добавить в проект 
через вкладки меню Project → Add files to Project, где указывается имя 

файла: «lab1.c». После этого имя данного файла появится в разделе 
«Source» окна проекта. Кроме файла программы, через вкладку меню 

Project → Add files to Project необходимо добавить в проект файл 

управления линкером и библиотеки: 

 
C:\tidcs\c28\dsp281x\v100\DSP281x_common\cmd\F2812_EzDSP_RAM_lnk.cmd 
C:\CCStudio_v3.3\C2000\cgtools\lib\rts2800_ml.lib 
 

Рекомендуется здесь и далее в аналогичных случаях для исклю-

чения ошибок полные пути к файлам копировать в диалоговое окно 

«Add files to Project». 

 

4. Компиляция программы. 

Компилируя программу, мы проверяем её на наличие синтакси-

ческих ошибок. Для этого выбираем вкладку меню Project → Compile 

File (горячие клавиши Ctrl+F7) или иконку . В случае удачной 

компиляции в статусной строке будет выдано сообщение об отсутст-
вии ошибок: 

«Compile Complete, 

  0 Errors, 0 Warnings, 0 Remarks.» 

 

5. Добавление библиотек и создание стека. 
Подключаем Си-библиотеки: 

Project → Build Options → Linker → Libraries → Search Path: 

C:\CCStudio_v3.3\C2000\cgtools\lib 

Project → Build Options → Linker → Libraries → Search Path Linker → 

Incl. Libraries: rts2800_ml.lib 
 

 Задаем глубину стека 0х400: 
Project → Build Options → Linker → Basic → Stack Size (-stack): 0x400 
(здесь и далее в формате записи числовых значений префикс «0x» оз-
начает hex-формат). 
 

 6. Компоновка и загрузка выходного файла в отладочный мо-

дуль eZDSP. 
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Для компоновки выбираем Project → Build (горячая клавиша F7) 

или . Открывается окно, в котором указывается наличие или отсут-
ствие ошибок, предупреждений и замечаний. Результатом компонов-

ки будет файл в hex-коде, содержащий коды программ и необходи-

мую отладочную информацию. Далее необходимо загрузить создан-

ный файл в эмулятор-отладчик через вкладку меню: File→Load Pro-

gram→Debug\lab1.out. После этого тестовая программа загрузится в 

память ЦСП, расположенного на плате эмулятора. Функцию загрузки 

готового out-файла в память ЦСП можно настроить автоматически, 

включив опцию Load Program After Build через меню Op-

tion→Customize→Program/Project/CIO. 

Замечания:  

1) Имя выходного файла генерируется по имени проекта, а не 
имени файла программы.  

2) При модификации программы необходимо каждый раз ком-

поновать и загружать программу в память процессора. 
 

 7. Сброс сигнального процессора и запуск программы на выпол-

нение. 
 Для правильного выполнения программы необходимо произве-
сти сброс процессора и его перезапуск. Для этого последовательно 

выполняются директивы Debug → Reset CPU (горячие клавиши 

Ctrl+R) и Debug → Restart (горячие клавиши Ctrl+Shift+F5) . 

Затем с помощью директивы Debug → Go Main (горячая клави-

ша Ctrl+M) устанавливаем программный счетчик на точку «void 

main (void)» основной программы. Директива Go Main позволяет 
выполнить начальную установку процессора, генерируемую компи-

лятором языка Си. Положение программного счетчика отображается 

желтой стрелкой у левого края рабочей области. 

Запуск программы на выполнение может осуществляться в по-

шаговом  и в автоматическом режимах.  

Запуск программы в автоматическом режиме осуществляется 

через вкладку меню Debug → Run (горячая клавиша F5) или с помо-

щью иконки  . При этом в строке статуса внизу рабочей области 

индицируется зелёная лампочка и появляется надпись Running. Оста-
новить выполнение программы можно через вкладку меню Debug → 

Halt (горячие клавиши Shift+F5) или .  
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Пошаговая отладка осуществляется с помощью Debug → Step 

Into или горячей клавиши F11. Нажимая функциональную клавишу 

F11, понаблюдайте за ходом выполнения программы. 

 

8. Просмотр переменных. 

Для просмотра переменных используется вкладка меню View → 

Watch Window или . В колонке Name задается имя переменной, в 

нашем случае там могут быть записаны переменные i и k (для добав-

ления переменной можно, выделив ее, воспользоваться в контекстном 

меню опцией Add to Watch Window). В колонке Value отображаются 

сами переменные, причем после каждой их модификации вручную 

или исполняемой программой они выделяются красным цветом в те-
чение одного такта отладки. В колонке Type отображается тип пере-
менной (целый, вещественный и т.д.), а в колонке Radix – задается 

формат представления чисел (десятичный, двоичный, шестнадцате-
ричный и пр.).  В окне Watch Window также можно просматривать 

также содержимое всех программно доступных регистров ЦСП. Для 

этого необходимо навести мышь на область окна, щелкнуть правой 

кнопкой мыши, из открывшегося списка выбрать «Add Globals to 

Watch», и поставить отметку напротив той группы регистров ЦСП, 

которую следует просматривать в ходе выполнения программы. 

 

9. Использование точки останова (Breakpoint). 

Точки останова (Breakpoint) в Code Composer Studio использу-

ются для удобства отладки программ. Для установки Breakpoint уста-
навливаем курсор на строку, на которой должно остановиться выпол-

нение программы, щелкаем на , строка выделяется красной точ-

кой. Запускаем программу (F5) и видим, что её выполнение останови-

лось на выделенной строке (желтая стрелка). Чтобы снять все Break-

point, необходимо щелкнуть на иконку . При достижении точки 

Breakpoint  в автоматическом режиме (Run) обновление переменных в 

окне Watch происходит дискретно с остановкой программы (далее 
требуется перезапуск). 

Измените исходную программу (рис. 1.3) так, как показано на 
рис. 1.4. 

 
unsigned int k; 
void main (void) 
{ 
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unsigned int i; 
while(1) 
{ 
for (i=0;i<100;i++) 
{ 
k=2; 
k=i*i; 
} 
} 
} 

Рис. 1.4. Измененная тестовая программа 
 

 

10. Режим Animate. 

Режим Animate используется для отслеживания содержимого 

регистров и переменных. Для его запуска необходимо нажать Debug 

→ Animate (горячие клавиши Shift+F5) или . Скорость анимации 

устанавливается в окне Option → Customize → Debug Properties → 

Animate Speed. Установите скорость анимации, равную 1 сек.  

 

11. Просмотр содержимого регистров. 

Содержимое регистров процессора  можно отследить, выбрав 

вкладку меню View → Registers → CPU Register и View → Registers 

→ Status Register. Чтобы изменить значение регистра, необходимо 

дважды щелкнуть по его содержимому и ввести новое значение. 
 

Задание для самостоятельной работы 

 

1. Установите Breakpoint на строки 7, 9 и 10 измененной тесто-

вой программы, показанной на рис. 1.4. Перезапускайте программу в 

автоматическом режиме (Run) после каждой остановки в выполнении 

программы на точках останова. Проследите изменение переменных  

i и k в окне Watch. Объясните полученные результаты. 

2. Не снимая Breakpoint, запустите программу в режиме 
Animate. Проследите выполнение программы, содержимого окна 
Watch (переменные i и k). Объясните полученные результаты.  

3. Открыв окна CPU Register и Status Register, проследите изме-
нение содержимого регистров при выполнении программы в режиме 
Animate. Объясните полученные результаты.  

4. Не останавливая выполнение программы, откройте окно ас-
семблированного кода программы, полученного в результате компо-

новки (Window → Disassembly). Объясните полученные результаты. 
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Вернитесь в окно исходного кода программы, написанной на языке 
Си (Window → Lab1.c). Остановите выполнение программы. Снимите 
все Breakpoint. 

 

 

Содержание отчета: 

 

Отчет должен содержать цель работы, краткие теоретические 
сведения по теме работы, тексты тестовых программ, результаты их 

выполнения, выводы. 

 

 

Контрольные вопросы: 

 

1. Структура платы эмулятора eZDSP320F2812 и платы расшире-
ния Zwickau Adapterboard. 

2. Среда разработки Code Composer Studio. Создание, компиляция, 

компоновка и загрузка проекта. 
3. Среда разработки Code Composer Studio. Режимы запуска про-

грамм. 

4. Среда разработки Code Composer Studio. Просмотр переменных.  

5. Среда разработки Code Composer Studio. Использование точки 

останова (Breakpoint). 

6. Среда разработки Code Composer Studio. Просмотр содержимого 

регистров ЦСП. 

7. Каким образом осуществить отладку исследуемой программы в 

пошаговом режиме: 
- без исследования ассемблерного кода; 
- с исследованием ассемблерного кода; 
- с одновременным исследованием исходного текста на Си и 

соответствующего ему ассемблерного кода. 
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Лабораторная работа № 2 
 Изучение карты памяти, структуры цифровых портов ввода/ 

вывода и системы тактирования ЦСП TMS320F2812 
 

Цель работы: изучить карту памяти, структуру цифровых пор-
тов ввода-вывода и системы тактирования ЦСП, научиться выполнять 
настройку данных модулей, вводить и выводить цифровые сигналы. 

 
Теоретические сведения 

 
Структурная схема ЦСП семейства C28x приведена на рис. 2.1. 

Память и все периферийные модули объединены системой шин по 
модифицированной гарвардской архитектуре. 

 

 

Рис. 2.1. Структурная схема ЦСП семейства C28x 
 
Карта адресного пространства ЦСП C28x показана на рис. 2.2. В 

качестве памяти данных используется исключительно ОЗУ быстрого 
доступа (Single Access RAM – SARAM, доступ возможен в течение 
каждого машинного цикла) общим объёмом 18 Кслов,  состоящее из 
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нескольких банков – М0, M1 (2x1К), L0, L1 (2x4К) и Н0 (8К). Каждый 
банк отображается и на память программ, и на память данных, т.е. эту 
память можно использовать и  в качестве памяти программ, и в каче-
стве памяти данных. В сигнальных процессорах F2812 объём встро-
енной флэш-памяти составляет 128 Кслов (4 сектора по 8К и 6 секто-
ров по 16К). 

В процессоре C28x, помимо центрального процессорного уст-
ройства (CPU) имеется внутренняя периферия (АЦП, таймеры, встро-
енные интерфейсы и пр.), которая также располагается на кристалле. 
ЦСП семейства С28x содержат регистры модуля центрального про-
цессора (регистры CPU), необходимые для арифметиче-
ской/логической обработки данных и три сегмента (фрейма) регист-
ров встроенной периферии, предназначенных для управления режи-
мами и хранения данных внутренних периферийных устройств. Эти 
регистры расположены прямо в адресном пространстве памяти, т.е. 
доступны не только как регистры с именами, но и как ячейки памяти 
с определенными адресами (см. рис. 2.2).  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 2.2. Карта адресного пространства ЦСП семейства C28x 
 
Peripheral Frame 0 (PF0, объем 2K, адреса 0x00 0800… 

0x00 0FFF) – включает в себя регистры внешнего интерфейса памяти 
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XINTF, модуля расширения прерываний PIE, модуля Flash-памяти, 
модуля таймеров ядра, модуля ключа защиты CSM; 

Peripheral Frame 2 (PF2, объем 4K, адреса 0x00 6000…0x00 6FFF) – 
включает в себя регистры интерфейса eCAN; 

Peripheral Frame 1 (PF1, объем 4K, адреса 0x00 7000… 
0x00 7FFF) – включает в себя регистры модуля управления системой, 
модуля ввода-вывода GPIO, модуля менеджеров событий EVA/EVB, 
модуля последовательного интерфейса McBSP, модуля последова-
тельного интерфейса SCI, модуля последовательного интерфейса SPI, 
модуля АЦП. 

Все программно доступные цифровые выводы сгруппированы в 
порты GPIOA, GPIOB, GPIOD, GPIOE, GPIOF, GPIOG. GPIO (general 
purpose input/output) означает «линии ввода/вывода общего назначе-
ния». 

Периферия имеет выводы, использующиеся для ввода/вывода 
сигналов. Чтобы не загромождать ЦСП дополнительными выводами, 
используют мультиплексирование: на одном выводе могут быть реа-
лизованы две и более различные функции, которые выбираются про-
граммным путем. На рис. 2.3 приведены основные и альтернативные 
функции портов. 

 

 

Рис. 2.3. Основные и альтернативные функции портов ввода-
вывода F2812 
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Все 6 портов управляются своими мультиплексирующими реги-
страми (GPxMUX, здесь и далее в именах регистров, относящихся к 
портам, x – имя порта). Если бит сброшен в 0, то данный вывод рабо-
тает как обычная линия порта; установкой бита в 1 выбирается аль-
тернативная функция, т.е. линия порта (pin) подключается к соответ-
ствующему периферийному устройству (см. рис. 2.4). К регистрам 
данных относятся: 

- регистры GPxDAT (в них непосредственно хранятся данные 
порта, которые могут быть изменены записью в данные регистры); 

- регистры GPxSET (служат для установки соответствующих 
разрядов порта); 

- регистры GPxCLEAR (служат для сброса соответствующих 
разрядов порта); 

- регистры GPxTOGGLE (служат для переключения соответст-
вующих разрядов порта в альтернативное логическое состояние). 

 

 
  

Рис. 2.4. Функциональная схема линии GPIO 
 
Каждый вывод порта может работать на ввод или вывод. На-

правление передачи данных задается битами в регистрах  GPxDIR:  
0 – линия работает на ввод, 1 – на вывод данных. При работе портов 
A, B, D и E на ввод для увеличения помехозащищенности можно на-

 

 

Периферийная 

функция 
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строить функцию задержки ввода (Input Qualification feature) установ-
кой битов 7-0 в соответствующем регистре GPxQUAL. После этого 
импульсы на линиях соответствующих портов, имеющие максималь-
ную длительность от 2 (GPxQUAL=0x01) до 510 (GPxQUAL=0xFF) пе-
риодов частоты тактирования ядра SYSCLKOUT, не будут распозна-
ваться ядром процессора. 

Перед началом работы необходимо настроить модуль тактиро-
вания. Как и многие современные процессоры, ЦСП семейства С28х 
используют внешний резонатор или генератор с частотой более низ-
кой, чем максимальная тактовая. Это позволяет уменьшить влияние 
электромагнитных помех, понизить требования к разводке печатной 
платы и повысить надежность работы схемы. Частота тактового гене-
ратора OSCCLK, расположенного на плате эмулятора, составляет  
30 МГц. Максимальная тактовая частота процессора 150 МГц получа-
ется путем умножения внешней частоты на 5 (OSCCLK*10/2, см. рис. 
2.5). Коэффициент деления задается программно в регистре PLLCR.  
 

 
Рис. 2.5. Тактовый модуль и регистр PLLCR 

 
Помимо формирователя тактовой частоты ядра, тактовый мо-

дуль содержит предделители: низкоскоростной LOSPCP и высокоско-

ростной HISPCP (рис. 2.6), которые используются для тактирования 

периферийных устройств. 
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Известно, что потребляемая мощность микропроцессорных эле-
ментов возрастает пропорционально тактовой частоте. Снижая такто-

вую частоту, можно снизить энергопотребление и определенного моду-

ля, и всего ЦСП в целом. Коэффициенты деления задаются программно 

в регистрах LOSPCP и HISPCP. 

 

Рис. 2.6. Формат регистров HISPCP и LOSPCP 

В ЦСП семейства С28х реализована возможность не только из-
менять, но и полностью запрещать/разрешать тактирование различных 

периферийных модулей при помощи регистра PCLKCR (рис. 2.7). 

 

 
 

EVAENCLK Разрешение HSPCLK в EVA  

EVBENCLK  Разрешение HSPCLK в EVВ  

ADCENCLK  Разрешение HSPCLK в АЦП (ADC)  

SPIAENCLK  Разрешение LSPCLK в SPI  

SCIAENCLK  Разрешение LSPCLK в SCI-A  

SCIBENCLK  Разрешение LSPCLK в SCI-B  

MCBSPENCLK  Разрешение LSPCLK в McBSP  

ECANENCLK  Разрешение тактирования eCAN 

Рис. 2.7. Формат регистра PCLKCR: 1 – разрешить тактирование 
периферийного модуля; 0 – запретить. 
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Сторожевой таймер (Watchdog timer или WDT, рис. 2.8) предна-
значен для предотвращения «зависания» ядра ЦСП и реализован на 
основе суммирующего счетчика WDCNTR, который тактируется че-
рез счетчик-делитель от внешнего генератора и при переполнении 

вырабатывает сигнал прерывания WDINT либо сброса ядра ЦСП 

WDRST (задается программно). WDT работает независимо от ядра 
ЦСП и должен сбрасываться программно для предотвращения сброса 
процессора. 

Сторожевой таймер защищен ключом «101», и, в случае записи в 

биты WDCHK 2–0 регистра WDCR (рис. 2.9) любой иной кодовой 

комбинации, в следующем машинном цикле происходит генерация 

выходного сигнала (такого же, как и при переполнении).  Для предот-
вращения сброса ЦСП необходимо периодически программно сбра-
сывать счетчик WDCNTR при помощи записи последовательности 

кодов «0x55 + 0xAA» в специальный регистр WDKEY. 

 

 
 

Рис. 2.8. Функциональная схема сторожевого таймера 
 

 

Сброс WDT 

WDOVERRIDE 
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Рис. 2.9. Формат регистра управления сторожевого таймера WDCR 

 
Бит WDFLAG используется для того, чтобы указать источник 

сброса:  обычный сброс (WDFLAG=0) или сброс по сторожевому 
таймеру (WDFLAG=1).  Биты WDPS 2–0 позволяют выбрать необхо-
димый коэффициент деления частоты для работы сторожевого тайме-
ра. Бит WDDIS служит для запрета работы (блокировки) WDT. 

Регистр управления и состояния (System Control and Status  
Register – SCSR, рис. 2.10) управляет сбросом сторожевого таймера. 
Бит WDINTS отражает текущее состояние сигнала WDINT. Бит 
WDENINT – выбор режима действия от WDT (сброс или прерыва-
ние). Если WDENINT=0 – разрешен сигнал сброса WDRST, если 
WDENINT=1 – разрешен сигнал прерывания WDINT. 

Если бит WDOVERRIDE установлен в 1, то пользователь может 
изменять состояние сторожевого таймера, т.е. запрещать или разре-
шать его работу с помощью бита WDDIS в регистре управления 
WDCR. Особенностью является то, что пользователь может только 
сбросить бит WDOVERRIDE, записав в него «1», установить бит 
программно нельзя.  

 

 
 

Рис. 2.10. Формат регистра управления и состояния SCSR 
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Ход работы 

 

Часть I 

 
В части I лабораторной работы необходимо разработать про-

грамму «бегущие огни», задавая направление движения: сначала – от 
края к краю (см. рис. 2.11, а), а потом, зажигая по два светодиода, – от 
периферии к центру (см. рис. 2.11, б). Светодиоды подключены  к ли-
ниям порта GPIOB7 – GPIOB0 (1 – горит, 0 – погашен), а линии порта 
GPIOB15 – GPIOB8 соединены с ключами (1 – ключ замкнут, 0 – ра-
зомкнут). 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Рис. 2.11. Направление движения светодиодов: а) – слева 
направо и наоборот; б) – от периферии к центру и наоборот 

 
1. Создание нового проекта. 
В Code Composer Studio создаем новый проект Lab2.pjt. В поле 

Project Name записываем название проекта «Lab2». В поле Location 
указывается путь, по которому будет находиться проект – 
E:\DspUser\Lab2. 

1.1. Для упрощения работы файл под именем «_lab2_.c» с заго-
товкой текста программы имеется на диске в папке 
«E:\DspUser\Templates». Знаками «?» в исходном тексте программы 

отмечены значения, которые необходимо будет заменить на требуе-

а)

0 1 2 3 4 5 6 7 
GPIOB

0 1 2 3 4 5 6 7 
GPIOB

б)
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мые для правильной работы программы (рис. 2.12). Копируем данный 
файл в папку проекта E:\DspUser\Lab2 и переименовываем в «Lab2.c». 
Добавляем в проект и открываем в окне редактора данный файл:  
Project → Add files to Project.   

1.2. Добавляем в проект управляющий файл линкера, команд-
ные файлы, библиотеки, необходимые внешние программные модули 
(рекомендуется для исключения ошибок пути к файлам, указанные 
ниже, копировать в диалоговое окно «Add files to Project»): 

 
C:\tidcs\c28\dsp281x\v100\DSP281x_common\cmd\F2812_EzDSP_RAM_lnk.cmd 
C:\tidcs\c28\dsp281x\v100\DSP281x_headers\cmd\DSP281x_Headers_nonBIOS.cmd 
C:\CCStudio_v3.3\C2000\cgtools\lib\rts2800_ml.lib 
C:\tidcs\c28\dsp281x\v100\DSP281x_headers\source\DSP281x_GlobalVariableDefs.c 

 
2. Настройка параметров проекта. 
2.1. Включаем в проект заголовочные файлы, для этого выбира-

ем Project →  Build Options, в закладке Compiler выбираем Preproces-
sor и в поле Include Search Path (-i) вводим:  

C:\tidcs\C28\dsp281x\v100\DSP281x_headers\include;..\include 
2.2. Добавление библиотек и создание стека. 
Подключаем Си-библиотеки: 

Project → Build Options → Linker → Libraries → Search Path: 
C:\CCStudio_v3.3\C2000\cgtools\lib 
Project → Build Options → Linker → Libraries → Search Path Linker → 
Incl. Libraries: rts2800_ml.lib 

Задаем глубину стека 0х400: 
Project → Build Options → Linker → Basic → Stack Size (-stack): 0x400 
 
//################################################################## 
// Имя файла: _Lab2_.c 
// 
// Описание: С помощью 8 светодиодов, подключенных к линиям  
// порта GPIOB0 - GPIOB7, формируются "бегущие огни". 
// Направление движения справа - налево и наоборот 
//################################################################## 
 
#include "DSP281x_Device.h" // Включение заголовочного файла 
 
void delay_loop(long); 
void Gpio_select(void); 
void InitSystem(void); 
 
void main(void) 
{ 
 unsigned int i; 
 unsigned int LED[8]= {0x0001,0x0002,0x0004,0x0008, 
                       0x0010,0x0020,0x0040,0x0080};  
  
 InitSystem();  // Инициализация регистров ЦСП 
 Gpio_select();  // Инициализация линий ввода/вывода  
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while(1) 
 {     
       for(i=0;i<14;i++) 
    { 
          if(i<7)  GpioDataRegs.GPBDAT.all = LED[i]; 
          else   GpioDataRegs.GPBDAT.all = LED[14-i];  
          delay_loop(?); 

      } 
     } 
}   
 
//################################################################## 
// Подпрограмма: delay_loop 
// 
// Описание: Формирование временной задержки горения светодиодов 
//################################################################## 
 
void delay_loop(long end) 
{ 
 long i; 
 for (i = 0; i < end; i++); 
 EALLOW; // Сброс сторожевого таймера 
 //SysCtrlRegs.WDKEY = 0x?; 
 //SysCtrlRegs.WDKEY = 0x?; 
 EDIS; 
} 
 
//################################################################## 
// Подпрограмма: Gpio_select 
// 
// Описание: Настройка линий порта GPIO B15-8 на ввод, а линий  
// B7-0 на вывод. Настройка всех линий портов A, D, F, E, G на  
// ввод. Запрещение работы входного ограничителя 
//################################################################## 
 
void Gpio_select(void) 
{ 
 EALLOW; 
    GpioMuxRegs.GPAMUX.all = 0x?; // Настройка линий ввода/вывода на 
    GpioMuxRegs.GPBMUX.all = 0x?; // работу в качестве портов    
    GpioMuxRegs.GPDMUX.all = 0x?; 
    GpioMuxRegs.GPFMUX.all = 0x?;    
    GpioMuxRegs.GPEMUX.all = 0x?;  
    GpioMuxRegs.GPGMUX.all = 0x?;   
    GpioMuxRegs.GPADIR.all = 0x?; // Настройка портов А, D, E, F, G  

  // на ввод 
    GpioMuxRegs.GPBDIR.all = 0x?; // Настройка линий 15-8 на ввод,  
    GpioMuxRegs.GPDDIR.all = 0x?; // а линий 7-0 на вывод 
    GpioMuxRegs.GPEDIR.all = 0x?;  
    GpioMuxRegs.GPFDIR.all = 0x?;  
    GpioMuxRegs.GPGDIR.all = 0x?;  
 
    GpioMuxRegs.GPAQUAL.all = 0x?; // Запрещение входного ограничителя 
    GpioMuxRegs.GPBQUAL.all = 0x?; 
    GpioMuxRegs.GPDQUAL.all = 0x?; 
    GpioMuxRegs.GPEQUAL.all = 0x?; 
    EDIS; 
}      
 
 
//##################################################################### 
// Подпрограмма: InitSystem 
// 
// Описание: Настройка сторожевого таймера на работу, 
//  предделитель = 1. Выработка сброса сторожевым  
//  таймером. Внутренняя частота работы ЦСП 150 МГц. 
//  Запись в предделитель высокоскоростного таймера  

7 

5 

6
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//  коэффициента деления 2, а в предделитель 
//  низкоскоростного таймера - 4. Запрещение работы  
//  периферийных устройств 
//##################################################################### 
 
void InitSystem(void) 
{ 
    EALLOW; 
    SysCtrlRegs.WDCR= 0x?;  // Разрешение работы сторожевого    
      // таймера, предделитель = 64 
      // или запрещение работы  сторо- 
      // жевого таймера, предделитель = 1 
  
    SysCtrlRegs.SCSR = ?;   // Конфигурирование сброса ЦСП от WDT
  

    SysCtrlRegs.PLLCR.bit.DIV = ?;// Настройка блока умножения частоты 
      SysCtrlRegs.HISPCP.all = 0x?;// Задание значений высокоскоростного 

SysCtrlRegs.LOSPCP.all = 0x?; // и низкоскоростного предделителей  
       

 
    SysCtrlRegs.PCLKCR.bit.EVAENCLK=?; // Запрещение работы 
    SysCtrlRegs.PCLKCR.bit.EVBENCLK=?; // периферийных устройств 
    SysCtrlRegs.PCLKCR.bit.SCIAENCLK=?; 
    SysCtrlRegs.PCLKCR.bit.SCIBENCLK=?; 
    SysCtrlRegs.PCLKCR.bit.MCBSPENCLK=?; 
    SysCtrlRegs.PCLKCR.bit.SPIENCLK=?; 
    SysCtrlRegs.PCLKCR.bit.ECANENCLK=?; 
    SysCtrlRegs.PCLKCR.bit.ADCENCLK=?; 
    EDIS; 
} 

 
 

Рис. 2.12. Заготовка текста программы «бегущие огни» 
 
3. Инициализация системы. 
Открываем файл Lab2.c и переходим к подпрограмме  

«InitSystem()». 

 3.1. Присваивая необходимое значение регистру WDCR (см. 
рис. 2.9), запрещаем работу сторожевого таймера (WDDIS=0), сбра-
сываем бит WDFLAG, задаем коэффициент деления частоты тактиро-
вания Watchdog-таймера, равный 1 (WDPS0, WDPS1, WDPS2=0). 
Указанные значения нужно  внести в область 1 программы  
(см. рис. 2.12). 
 3.2. Программируем регистр SCSR (см. рис. 2.10) на сброс про-
цессора при переполнении Watchdog-таймера. В бит WDENINT запи-
сываем «0», в бит WDOVERRIDE также записываем «0» для того, 
чтобы оставить его в единичном состоянии (см. область 2 на  
рис. 2.12). 
 3.3. В регистр PLLCR (см. рис. 2.5) заносим код, необходимый 
для преобразования частоты кварцевого резонатора 30 МГц во внут-
реннюю частоту SYSCLKOUT работы процессора 150 МГц (см. об-
ласть 3 на рис. 2.12). 

1

2 

3

4
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 3.4. Заносим в высокоскоростной предделитель HISPCP  
(см. рис. 2.6) коэффициент деления 2, а в низкоскоростной (LOSPCP) 
– 4 (см. область 3 на рис. 2.12). 
 3.5. Установкой-сбросом бит в регистре PCLKCR (см. рис. 2.7) 
запрещаем работу всех периферийных устройств (см. область 4 на 
рис. 2.12). 
 
 4. Настройка портов. 
Переходим к подпрограмме «Gpio_select()». 

 4.1. Установкой-сбросом бит в регистрах GPxMUX настраиваем 
все выводы на работу в качестве портов (см. область 5 на рис. 2.12). 
 4.2. Установкой-сбросом бит в регистрах GPxDIR настраиваем 
все линии портов A, D, E, F, G на ввод (см. область 5 на рис. 2.12).  
В порту GPIOB настраиваем линии порта GPIOB15 – GPIOB8 на ввод, 
а GPIOB7 – GPIOB0 на вывод (см. область 5 на рис. 2.12). 
 4.4. Сбрасываем все биты регистров GPxQUAL портов A, B, D, 
E  в ноль (см. область 5 на рис. 2.12). 
 

5. Расчет и задание временной задержки 
В строке «delay_loop()» (см. область 6 на рис. 2.12) в скоб-

ках указываем число n – параметр задержки. Длительность задержки 
будет пропорциональна данному числу и рассчитывается по формуле 
(в секундах): 
 

610150

6





n

tзд . 

 
6. Компиляция, компоновка и загрузка выходного файла в отла-

дочный модуль ЦСП. 
6.1. Компилируем программу: Project → Compile File. При нали-

чии ошибок, исправляем их. 
6.2. Компонуем проект: Project → Build. При наличии ошибок, 

исправляем их. 
6.3. Загружаем выходной файл: File → Load Program → Debug\ 

lab2.out (в случае, если данная функция сконфигурирована для вы-
полнения автоматически, выполнять данный пункт не нужно).  
 
 7.  Тестирование программы.  

7.1. Сбрасываем ЦСП: Debug → Reset CPU, Debug → Restart. 
 7.2. Устанавливаем программный счетчик на точку «void 
main (void)» основной программы: Debug → Go main. 
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7.3. Запускаем программу: Debug → Run. Проверяем правиль-
ность работы, наблюдая за светодиодами. 

Имеется возможность отслеживать правильность выполнения 
логики программы, просматривая в отдельном окне, как изменяется 
содержимое выводов порта GPIOB. Для этого необходимо: 

- остановить выполнение программы; 
- установить точку останова на строку программы, отмеченную 

знаком «●»; 
- выделить мышью в любом месте текста программы  название 

«GpioDataRegs.GPBDAT», нажать правую кнопку мыши и в открыв-
шемся окне выбрать «Add to Watch Window»; 

- щелкнуть по значку «+» напротив имени 
«GpioDataRegs.GPBDAT» в окне Watch Window, далее выбрать «bit», 
после чего в данном окне будут выведены в столбик двоичные со-
стояния разрядов порта GPIOB (рис. 2.13); 

- исключить из программы (закомментировать) задержку, вста-
вив символы «//» в начало строки  delay_loop(?); 

- сохранить проект (Project → Save), выполнить компиляцию и 
линковку измененного проекта; 

- запустив программу в режиме «Animate», наблюдать последо-
вательность изменения логических уровней на линиях порта GPIOB. 

 
8. Работа со сторожевым таймером. 
8.1. Останавливаем выполнение программы. 
8.2. В подпрограмме «InitSystem()» изменением содержи-

мого регистра WDCR разрешаем работу сторожевого таймера (см. об-
ласть 1 на рис. 2.12). В битовом поле WDPS этого регистра задаем ко-
эффициент деления программного предделителя равным 64 (см. рис. 
2.8, 2.9). 

8.3. В подпрограмме временной задержки «delay_loop()» 

удаляем символы «//» перед двумя строками программы, в которых 
должна производиться запись в регистр WDKEY (см. область 7 на 
рис. 2.12), и записываем кодовую комбинацию для сброса Watchdog-
таймера: SysCtrlRegs.WDKEY = 0x55, SysCtrlRegs.WDKEY 
= 0xAA. 

Расчетное время до формирования импульса сброса /WDRST от 
Watchdog-таймера в выбранном режиме составит: 

 

.28,0
1030

25664512
6

сtWDRST 



  
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Для того чтобы сброс WDT происходил раньше (т.е. сброса 
ЦСП не происходило), нужно обеспечить соотношение tзд ≤ tWDRST. 

8.4. Компилируем, компонуем проект и тестируем программу. 
 

 
 

Рис. 2.13. Просмотр состояния двоичных разрядов порта GPIOB 
в окне Watch Window 

 
9. Работа с двумя светодиодами. 

 9.1. Копируем содержимое файла «Lab2.c» в новый файл, кото-
рый называем «Lab2a.c».  

9.2. Преобразуем программу Lab2a.c так, чтобы одновременно 
зажигались два светодиода в направлении от периферии к центру  
(см. рис. 2.11, б). 

9.3. Добавляем в проект «Lab2a.c» и удаляем «Lab2.c» (щелкаем 
правой клавишей мышки и выбираем Remove from project). 

9.4. Компилируем, компонуем проект и тестируем программу. 
 

Часть II 
  

В части II лабораторной работы необходимо положение ключей 
отражать на светодиодах (ключ замкнут – светодиод горит, разомкнут 
– погашен), а также положением ключей задавать длительность све-
чения светодиодов. 

1. Отображение состояния ключей на светодиодах. 
1.1. Копируем содержимое файла «Lab2а.c» в новый файл, кото-

рый называем «Lab2b.c».  
1.2. Преобразуем программу Lab2b.c. Состояние (двоичный код), 

установленный ключами, должен индицироваться на светодиодах. С 
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учетом того, что для подключения и светодиодов, и ключей использу-
ется один и тот же порт (GPIOB), состояние ключей можно индициро-
вать, введя в основную программу команду циклического сдвига со-
держимого порта GPIOB на 8 бит: 

 
GpioDataRegs.GPBDAT.all = GpioDataRegs.GPBDAT.all >> 8 
 

Удаляем таблицу состояния светодиодов, а подпрограммы  
«InitSystem()» и «Gpio_select()» оставляем без изменений. 

1.3. Добавляем в проект «Lab2b.c» и удаляем «Lab2a.c».  
1.4. Компилируем, компонуем проект и тестируем программу. 
 
2. Формирование длительности свечения светодиодов в зависи-

мости от состояния ключей. 
2.1. Копируем содержимое файла «Lab2.c» в новый файл, кото-

рый называем «Lab2c.c».  
2.2. Преобразуем программу Lab2c.c. Задаем длительность за-

держки при  переключении  светодиодов  согласно рис. 2.11, а,  рав-
ную (0,1*N+0,001) сек, где N – код, заданный переключателями на 
линиях B15–B8. Подпрограммы «InitSystem()» и 

«Gpio_select()» оставляем без изменений. 

2.3. Добавляем в проект «Lab2c.c» и удаляем  «Lab2b.c».  
2.4. Компилируем, компонуем проект и тестируем программу. 

 

 

Содержание отчета: 

 

Отчет должен содержать цель работы, краткие теоретические 
сведения по теме работы, тексты исследуемых программ, результаты 

их выполнения, выводы. 

 

 

Контрольные вопросы: 

 

1. Структурная схема ЦСП семейства C28x. 

2. Карта адресного пространства ЦСП C28x. 

3. Структура портов ввода/вывода, режимы работы, регистры управ-

ления. 
4. Вывод простейших управляющих сигналов через порты 

TMS320F2812. 
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5. Система тактирования TMS320F2812. Структура, особенности, 

назначение регистров высокоскоростного и низкоскоростного 

предделителей. 

6. Watchdog timer: назначение, принцип действия, особенности. 

7. Какие изменения необходимо внести в исходный текст, чтобы 

программа «бегущие огни» запускалась по нажатию кнопки, 

присоединенной к линии порта GPIOD1, а останавливалась – по 

нажатию кнопки, присоединенной к линии порта GPIOD6  

(«0» – соответствующая кнопка нажата, «1» – кнопка отжата)?  

В исходном состоянии обе кнопки отжаты. 

8. Модифицируйте исходную программу таким образом, чтобы 

происходило движение одного «погашенного» светодиода среди 

остальных «горящих». 
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Лабораторная работа № 3 

Исследование системы прерываний и таймеров ядра 

ЦСП семейства C28х 

 

Цель работы: изучить систему прерываний процессоров семей-

ства С28х, а также таймеры ядра ЦСП.  Научиться создавать про-

граммы, использующие прерывания.  

 

Теоретические сведения 

 

Система прерываний ядра процессора C28x содержит  
16 линий прерываний (рис. 3.1). Два из них – немаскируемые (RS, 

NMI). Пользователь не может запретить данные прерывания.  Ос-
тальные 14 прерываний – маскируемые, т.е. пользователь может раз-
решить/запретить прерывания от них программно соответственно ус-
тановкой /сбросом соответствующих бит в регистре IER (Interrupt En-

able Register). Регистр IFR (Interrupt Flag Register) – регистр флагов 

прерываний. При обнаружении прерывания соответствующий бит ре-
гистра IFR защелкивается в единичном состоянии, а после обслужи-

вания прерывания – сбрасывается. Так же, когда аппаратное прерыва-
ние обслужено, или когда выполнена инструкция INTR, сбрасывается 

соответствующий бит регистра IER. 

 

 

Рис. 3.1. Линии прерываний ядра C28х 

 

  

ЯЯддрроо  

CC2288xx  

((CCoorree))  
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Общая структура прерываний ядра C28x показана на рис. 3.2, а 
форматы регистров IER и IFR – на рис. 3.3. Следует отметить, что 

программная установка одного из битов в регистре IFR приведет к 

обработке данного прерывания ядра таким же образом, как и в случае 
возникновения соответствующего прерывания. INTM – младший бит 
в статусном регистре ST1, служит для общего разрешения/запрета 
маскируемых прерываний ядра. 

 
 

Рис. 3.2. Общая структура прерываний ядра C28x 

 

 
 

 
Рис. 3.3. Форматы регистров IER и IFR 

 

Все 16 прерываний однозначно связаны в памяти с таблицей 

векторов прерываний ядра BROM vector (см. рис. 2.2), содержащей 

22-битные адреса (на каждое прерывание – 16 бит в ячейке с млад-

IFR   IER        INTM 

 

 

Ядро 

C28x 

Прерывание ожидает разрешения: IFRBit=1 

Прерывание отсутствует: IFRBit=0 

Прерывание разрешено: IERBit=1 

Прерывание запрещено: IERBit=0 
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шим адресом и 6 бит в ячейке со старшим адресом), по которым 

должны располагаться стартовые адреса подпрограмм обработки со-

ответствующих прерываний. Всего данная область памяти содержит 
32 таких вектора, т.к. к 16 прерываниям ядра добавлены прерывания 

DLOGINT, RTOSINT, Illegal (недопустимая инструкция), 12 про-

граммных прерываний USER1…USER12 и один резервный вектор 

(Reserved).  

Подача активного сигнала на вход сброса (на вывод /RS) вызо-

вет его сброс и перезапуск программы с начального адреса. Сброс от-
личается от остальных прерываний тем, что программа затем не воз-
вращается в исходную точку, а регистры сбрасываются в начальное 
состояние. Сброс может происходить как от внешнего источника, так 

и от сторожевого таймера (WDT). Сброс внешних схем при сбросе 
ядра процессора от WDT осуществляется через вывод /RS, который 

является двунаправленным.  

Особенностью ЦСП семейства C28x является возможность за-
пуска программ как из внутренней памяти (микроконтроллерный ре-
жим), так и из внешней (микропроцессорный режим). Режим опреде-
ляется состоянием вывода XMP/MC (см. рис. 2.2). Соответственно, 

после сброса программа переходит либо к начальному адресу  

0x3F FFC0 внутренней памяти (при XMP/MC=0), либо к тому же ад-

ресу внешней памяти (при XMP/MC=1), а режим запоминается с по-

мощью флага XMP/MC в регистре XINTCNF2, который может быть 

впоследствии обработан программно.  

После сброса в режиме микроконтроллера запускается служеб-

ная программа Bootloader, которая анализирует выводы порта GPIOF 

(GPIOF2, GPIOF3, GPIOF4 и GPIOF12) и, исходя из комбинации сиг-
налов на них, выполняет один из переходов, перечисленных в табл. 

3.1 и условно показанных на рис 3.4. 

В отладочном стенде ezDSP2812, используемом в лабораторных 

работах, программа загружается в H0 SARAM (ОЗУ), а прочие воз-
можные режимы загрузки могут быть заданы при помощи переклю-

чателей (джамперов). Следует отметить, что память программ и дан-

ных имеют единое адресное пространство, программа может выпол-

няться как из ОЗУ, так и из FLASH, или ПЗУ (ОТР). 
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Таблица 3.1. Режимы запуска программы Bootloader 

 

Выводы GPIO 

F4 F12 F3 F2
Режим запуска 

1 x x x 
Передать управление FLASH-памяти по адресу 

0x3F 7FF6 

0 0 1 0 
Передать управление H0 SARAM-памяти по адре-
су 0x3F 8000 

0 0 0 1 
Передать управление OTP-памяти по адресу 

0x3D 7800 

0 1 x x 
Загрузить программу из внешнего EEPROM во 

внутреннюю память через SPI-порт 

0 0 1 1 
Загрузить программу во внутреннюю память через 
SСI-А порт 

0 0 0 0 
Загрузить программу во внутреннюю память через 
параллельный порт GPIOВ 

 

 
Рис. 3.4. Режимы запуска программы Bootloader 

 
ЦСП имеет большое количество источников прерываний – 96, но 

только 16 линий прерываний ядра. Для возможности обслуживания 
всех прерываний для линий INT1…INT12 применяется мультиплекси-
рование (рис. 3.5). Т.к. программный поиск конкретного прерывания в 
линии при обработке программно занял бы длительное время, то при-

Стартовый адрес 
определяется 
состоянием  
линий порта 

GPIOF

Загрузочные  
программы 
(SPI, SCI-A, 
параллельная 
загрузка) 
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меняется специальный аппаратный модуль – Peripheral Interrupt Expan-
sion (PIE), или расширитель прерываний периферии. При работе с PIE 
происходит перенос области векторов:  каждому из 96 прерываний со-
ответствует свой 32-битный адрес в адресном пространстве – таблице 
векторов прерываний расширителя (PIE vector, адреса  
0x00 D000…0x00 DFFF, см. рис. 2.2 и 3.9).  Прерывания сгруппирова-
ны по 8 источников на линию (см. рис. 3.8). Для разрешения/запрета 
каждого прерывания используются биты в регистрах PIEIERx (x может 
принимать значения от 1 до 12), для индикации прерываний – биты в 
регистрах PIEIFRx. Соответствующий бит  в регистре подтверждения 
PIEACK  (активный уровень – 0) определяет номер активного преры-
вания для ядра CPU внутри группы. В результате каждая группа муль-
типлексируется в одно из прерываний ядра INT1…INT12  (рис. 3.6).  

Форматы регистров модуля расширителя прерываний PIEIERx  
и PIEIFRx показаны на рис. 3.7, данные регистры содержат по 8 ин-
формационных бит, т.е. по числу прерываний в группе. В регистре 
PIECTRL биты 15-1 (PIEVECT) показывают адрес в пределах табли-
цы векторов PIE vector, из которой был извлечен вектор. Младший 
значащий бит игнорируется и показываются биты адреса от 1 до 15 
(т.е. только четные адреса), что позволяет при чтении из регистра од-
нозначно определить, какое прерывание генерировалось. ENPIE – 
бит  разрешения извлечения векторов из таблицы PIE-контроллера. 
Если ENPIE=1, все вектора извлекаются из таблицы векторов PIE 
vector, а если ENPIE=0, PIE-контролер запрещен, и вектора извлека-
ются из таблицы CPU-векторов (BROM vector, см. рис. 2.2). 

  

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 3.3. Модуль прерываний С28х. 

 

Рис. 3.5. Логика работы регистров PIEIFRx, PIEIERx, PIEACKx 

x=1…12x=1…12

 
От 

периферии 
 и внешних 

прерываний

Ядро 
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Рис. 3.6. Общая структура расширения прерываний ЦСП С28х 

 

 

 
Рис. 3.7. Формат регистров модуля расширителя прерываний 

ЦСП С28х 
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Таблица векторов прерываний приведена на рис. 3.8.  
Примеры векторов прерываний:  
- прерывание от встроенного АЦП (ADCINT) – INT1.6;  
- прерывание от CPU-таймера 0 (TINT0) – INT1.7. 
 

 

Рис. 3.8. Таблица источников прерываний в PIE 
 

 

Рис. 3.9. Таблица векторов прерываний при ENPIE=1: вектор  
0x00 0D00 не активен, первичные вектора прерывания ядра по адресам  
0x00 0D02 по 0x00 0D1C переадресовываются в область  
0x00 0D40…0x00 0DFE с учетом конкретного источника прерывания 
периферии; вектор извлекается за 9 шагов (машинных циклов ЦСП). 

приоритет
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Рис. 3.10. Полная процедура обработки прерываний при 
ENPIE=1: шаг 1 – генерация прерывания от периферии; шаг 2 – уста-
новка флага PIEIFRx.y = 1; шаг 3а – проверка одновременного нали-
чия двух условий: PIEIERx.y = 1 и PIEACKx=0; шаг 3б – установка в 
«1» бита PIEACKx для подтверждения прерывания от группы x;  
шаг 4 – формирование импульса прерывания по линии INTx на ядро 
(PIEACKx продолжает оставаться в единичном состоянии и требует 
программного сброса для возможности  приема прерывания  ядром по 
линии INTx в дальнейшем); шаг 5 – установка флага IFRx = 1;  
шаг 6 – проверка условия IERx = 1; шаг 7 – проверка условия  
INTM = 1, подготовка адреса возврата и данных к сохранению в сте-
ке; шаг 8 – процессор определяет адрес вектора прерывания в области 
PIE Vector Mapping (адреса с 0x00 0D02 по 0x00 0D1C); шаг 9 – про-
цессор определяет первичный адрес вектора прерывания в области 
PIE Vector Mapping с учетом текущего значения регистров PIEIER и 
PIEIFR (адреса с 0x00 0D40 по 0x00 0DFE). 

 
В сигнальных процессорах семейства С28х имеется три  

32-битных таймера ядра (CPU timers) с одинаковой структурой. Схема 
одного таймера приведена на рис. 3.11.  Работа таймера разрешается 
сбросом бита TCR.4. Таймер имеет 16-битный предварительный де-
литель (прескалер) PSCH: PSC, который формирует счетный импульс 
вычитания из основного 32-битного счетчика TIMH: TIM. По дости-

ядро 
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жении счетчиком TIMH: TIM нуля формируется сигнал прерывания 
/TINT, поступающий на ядро. 16-битный регистр TDDRH: TDDR ис-
пользуется для перезагрузки прескалера таймера.  Регистр  
PRDH: PRD содержит значение основного 32-битного счетчика, пере-
загружаемое в него при очередном переопустошении. Данная каскад-
ная структура позволяет получить очень широкий диапазон коэффи-
циентов деления частоты: от 22

 до 2
48

. 
Таймеры 1 и 2, как правило,  используются для операционной 

системы реального времени «DSP/BIOS», в то время как таймер 0 ис-
пользуется для пользовательских приложений. Данные таймеры ин-
тегрированы в ЦСП, не следует их путать с таймерами менеджеров со-
бытий (EvA и EvB). Необходимо отметить, что после сброса разреша-
ется работа всех трех таймеров ядра. 

 

 

 

 

 

 

 

 

 

 

 

Рис. 3.11. Схема таймера ядра ЦСП семейства C28x (жирной ли-

нией показано прохождение тактового сигнала с делением частоты на 
выход) 

 

Полный набор программно доступных регистров, относящихся к 

таймерам ядра, показан на рис. 3.12. 

Счетчик-предделитель TIMERxPSC и регистр-делитель TIME-

RxTDDR программно доступны как один 16-разрядный регистр 

TIMERxTPR (см. рис. 3.13).  

Аналогично, регистры TIMERxPSCH и TIMERxTDDRH, про-

граммно представляют собой единый 16-битный регистр TIME-

RxTPRH. 
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Рис. 3.12. Регистры таймеров ядра ЦСП семейства C28x 

 

 
 

Рис. 3.13. Формат регистров-прескалеров TIMERxTPR (x = 0, 1, 2) 

 

Функции управления каждым из таймеров реализованы в реги-

страх управления TIMERxTCR, формат которых показан на рис. 3.14. 

Сигналы прерываний, формируемые CPU-таймерами, связаны с 
прерываниями ядра, как показано на рис. 3.15. Прерывание таймера 0 

происходит через PIE, а таймеров 1 и 2 – попадают напрямую на ядро 

через соответствующие линии. 
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Рис. 3.14. Формат регистров управления таймерами ядра 
(TIMERxTCR) 

 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 3.15. Сигналы прерываний от CPU-таймеров 

 

 

Ход работы 

 

Использование таймера позволяет более эффективно использо-

вать ресурсы процессора. Наиболее простые задачи для таймера – вы-

Флаг прерывания от 

таймера 

(очистка – записью «1») 

Разрешение  
прерывания от таймера 

(«1»-да, «0»-нет) 

Разрешение эмуляции 

(записью «1x») 

Бит перезагрузки  

таймера 

(«1» – перезагрузка) 

Статус таймера 

(«0» – старт, «1» – стоп) 
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зывать на выполнение периодические задачи либо инкрементировать 

глобальную переменную. Данная переменная будет пропорциональна 
машинному времени, прошедшему с момента запуска таймера.  

Для выполнения данной работы следует использовать файл с 
программой из предыдущей работы. Но вместо программной задерж-

ки в этот раз будем использовать аппаратную задержку, формируе-
мую таймером 0 ядра ЦСП. Данный таймер использует систему рас-
ширения прерываний (PIE).  

 

1. Создание нового проекта. 
В Code Composer Studio создаем новый проект Lab3.pjt. В поле 

Project Name записываем название проекта «Lab3». В поле Location 

указывается путь, по которому будет находиться проект – 

E:\DspUser\Lab3. 

1.1. Открываем файл с программой формирования бегущих ог-
ней из лабораторной работы №2  Lab2.с и сохраняем его под именем 

Lab3.с. Затем добавляем файл Lab3.с в проект: Project → Add files to 

Project. 

Структура исходного текста программы показана на рис. 3.16. 
1.2. Добавляем в проект управляющий файл линкера, командные 

файлы, библиотеки, необходимые внешние программные модули (ре-
комендуется для исключения ошибок пути к файлам, указанные ниже, 
копировать в диалоговое окно «Add files to Project»): 

 
C:\tidcs\c28\dsp281x\v100\DSP281x_common\cmd\F2812_EzDSP_RAM_lnk.cmd 
C:\tidcs\c28\dsp281x\v100\DSP281x_headers\cmd\DSP281x_Headers_nonBIOS.cmd 
C:\CCStudio_v3.3\C2000\cgtools\lib\rts2800_ml.lib 
C:\tidcs\c28\dsp281x\v100\DSP281x_headers\source\DSP281x_GlobalVariableDefs.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\source\DSP281x_PieCtrl.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\source\DSP281x_PieVect.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\source\DSP281x_DefaultIsr.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\source\DSP281x_CpuTimers.c 

 
2. Настройка параметров проекта. 
2.1. Включаем в проект заголовочные файлы, для этого выбира-

ем Project →  Build Options, в закладке Compiler выбираем Preproces-
sor и в поле Include Search Path (-i) вводим:  

C:\tidcs\C28\dsp281x\v100\DSP281x_headers\include;..\include 

2.2. Добавление библиотек и создание стека. 
Подключаем Си-библиотеки: 
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Project → Build Options → Linker → Libraries → Search Path: 

C:\CCStudio_v3.3\C2000\cgtools\lib 

Project → Build Options → Linker → Libraries → Search Path Linker → 

Incl. Libraries: rts2800_ml.lib 

Задаем глубину стека 0х400: 

Project → Build Options → Linker → Basic → Stack Size (-stack): 0x400 

 
//################################################################## 
// Имя файла: Lab3.c 
// 
// Описание: С помощью 8 светодиодов, подключенных к линиям  
//  порта GPIOB0 - GPIOB7, формируются "бегущие огни". 
//  Направление движения справа - налево и наоборот 
//##################################################################### 
 
#include "DSP281x_Device.h" // Включение заголовочного файла 
 
void delay_loop(long); 
void Gpio_select(void); 
void InitSystem(void); 
 
void main(void) 
{ 
 unsigned int i; 
 unsigned int LED[8]= {0x0001,0x0002,0x0004,0x0008, 
                       0x0010,0x0020,0x0040,0x0080};  
  
 InitSystem();  // Инициализация регистров ЦСП 
 Gpio_select();  // Инициализация линий ввода/вывода  
  
while(1) 
 {     
       for(i=0;i<14;i++) 
    { 
          if(i<7)  GpioDataRegs.GPBDAT.all = LED[i]; 
          else   GpioDataRegs.GPBDAT.all = LED[14-i];  
          delay_loop(?); 
      } 
     } 
}   
 
 
 
//##################################################################### 
// Подпрограмма: delay_loop 
// 
// Описание: Формирование временной задержки горения светодиодов 
//##################################################################### 
 
void delay_loop(long end) 
{ 
 long i; 
 for (i = 0; i < end; i++); 
 EALLOW; // Сброс сторожевого таймера 
 SysCtrlRegs.WDKEY = 0x?; 
 SysCtrlRegs.WDKEY = 0x?; 
 EDIS; 
} 
 
 
 
 

1

2

4

3

5 

7
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//##################################################################### 
// Подпрограмма: Gpio_select 
// 
// Описание: Настройка линий порта GPIO B15-8 на ввод, а линий B7-0  
//  на вывод. Настройка всех линий портов A, D, F, E, G на  
//  ввод. Запрещение работы входного ограничителя 
//##################################################################### 
 

void Gpio_select(void) 
{ 
 EALLOW; 
    GpioMuxRegs.GPAMUX.all = 0x?; // Настройка линий ввода/вывода на                    
    GpioMuxRegs.GPBMUX.all = 0x?; // работу в качестве портов    
    GpioMuxRegs.GPDMUX.all = 0x?; 
    GpioMuxRegs.GPFMUX.all = 0x?;    
    GpioMuxRegs.GPEMUX.all = 0x?;  

    GpioMuxRegs.GPGMUX.all = 0x?;    
           
    GpioMuxRegs.GPADIR.all = 0x?; // Настройка портов А, D, E, F, G на ввод 
    GpioMuxRegs.GPBDIR.all = 0x?; // Настройка линий 15-8 на ввод,  
    GpioMuxRegs.GPDDIR.all = 0x?; // а линий 7-0 на вывод 
    GpioMuxRegs.GPEDIR.all = 0x?;  
    GpioMuxRegs.GPFDIR.all = 0x?;  
    GpioMuxRegs.GPGDIR.all = 0x?;  
 

    GpioMuxRegs.GPAQUAL.all = 0x?; // Запрещение входного ограничителя 
    GpioMuxRegs.GPBQUAL.all = 0x?; 
    GpioMuxRegs.GPDQUAL.all = 0x?; 
    GpioMuxRegs.GPEQUAL.all = 0x?; 

    EDIS; 
}      
 
//##################################################################### 

// Подпрограмма: InitSystem 
// 
// Описание: Настройка сторожевого таймера на работу, 
//  предделитель = 1. Выработка сброса сторожевым  
//  таймером. Внутренняя частота работы ЦСП 150 МГц. 
//  Запись в предделитель высокоскоростного таймера  
//  коэффициента деления 2, а в предделитель 
//  низкоскоростного таймера - 4. Запрещение работы  
//  периферийных устройств 
//##################################################################### 
 
void InitSystem(void) 

{ 
    EALLOW; 
    SysCtrlRegs.WDCR= 0x?;  // Разрешение работы сторожевого    
      // таймера, предделитель = 64 
      // или запрещение работы  сторо- 
      // жевого таймера, предделитель = 1 
  
    SysCtrlRegs.SCSR = ?;   // Конфигурирование сброса ЦСП от WDT

  

    SysCtrlRegs.PLLCR.bit.DIV = ?;// Настройка блока умножения частоты 
      SysCtrlRegs.HISPCP.all = 0x?; // Задание значений высокоскоростного   
 SysCtrlRegs.LOSPCP.all = 0x?; // и низкоскоростного предделителей  

6
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    SysCtrlRegs.PCLKCR.bit.EVAENCLK=?; // Запрещение работы 
    SysCtrlRegs.PCLKCR.bit.EVBENCLK=?; // периферийных устройств 
    SysCtrlRegs.PCLKCR.bit.SCIAENCLK=?; 
    SysCtrlRegs.PCLKCR.bit.SCIBENCLK=?; 
    SysCtrlRegs.PCLKCR.bit.MCBSPENCLK=?; 
    SysCtrlRegs.PCLKCR.bit.SPIENCLK=?; 

    SysCtrlRegs.PCLKCR.bit.ECANENCLK=?; 
    SysCtrlRegs.PCLKCR.bit.ADCENCLK=?; 
    EDIS; 
} 

 
 

Рис. 3.16. Структура исходного текста программы 

 

3. Редактирование программы. 

 

3.1. В программе Lab3.c объявляем подпрограмму обработки 

прерываний от  CPU-таймера 0: 
 
interrupt void cpu_timer0_isr(void); 

 

Место вставки – область 1 на рис. 3.16. 

Далее в основной программе добавляем вызов подпрограммы: 
 
InitPieCtrl(); 

 

Место вставки – область 2 на рис. 3.16. 

Данная подпрограмма описана в файле DSP281x_PieCtrl.c, до-

бавленном в проект. Она позволяет очистить флаги и запретить все 
прерывания, что удобно при написании программ. Просмотреть и 

проанализировать содержимое данного файла можно, открыв его в 

другом окне редактора CCS. Аналогичным образом рекомендуется 

далее ознакомиться и с программами, хранящимися в прочих про-

граммных модулях, подключенных к проекту (файлы *.c). 

 

3.2. Непосредственно после вызова подпрограммы  

«InitPieCtrl();» добавляем еще один вызов подпрограммы: 

 
InitPieVectTable(); 
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Данная подпрограмма инициализирует область векторов PIE в 

начальное состояние. Она использует предварительно заданную таб-

лицу прерываний «PieVectTableInit()», которая определена в файле 
DSP281x_PieVect.c, и копирует эту таблицу в глобальную перемен-

ную «PieVectTable», которая связана с областью памяти процессора 
PIE area.  Также, для использования подпрограммы  

InitPieVectTable, в проект добавлен файл  DSP281x_DefaultIsr.c, 

который добавляет в проект подпрограммы обработки прерываний. 

 

3.3. Необходимо переопределить имя подпрограммы обработки 

прерываний от CPU-таймера 0 на нашу подпрограмму. Для этого в 

основную программу сразу после вызова подпрограммы  

«InitPieVectTable();» добавляем вызов следующих подпро-

грамм: 

 
EALLOW; 
PieVectTable.TINT0 = &cpu_timer0_isr; 
EDIS; 

 

Здесь EALLOW и EDIS – подпрограммы, используемые соот-
ветственно для разрешения и запрета доступа к системным регистрам 

процессора, а  «cpu_timer0_isr» – имя  подпрограммы обработки 

прерываний, описанной в программе ранее. 
 

3.4. Инициализируем CPU-таймер 0. В основную программу не-
обходимо добавить вызов подпрограммы (место вставки – сразу после 
команд, указанных в п. 3.3): 

 
InitCpuTimers(); 
 

Для возможности работы этой подпрограммы в проект добавлен 

файл DSP281x_CpuTimers.c. После этого таймер будет инициализи-

рован и остановлен. 

 

3.5. Необходимо настроить CPU Timer0 для генерации времен-

ных интервалов в 50 мс при тактовой частоте 150 МГц. Для этого сра-
зу после вызова  подпрограммы «InitCpuTimers();» добавляем 

вызов подпрограммы: 
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ConfigCpuTimer(&CpuTimer0, 150, 50000); 

 

Выполнение данной подпрограммы реализует файл 

DSP281x_CpuTimers.c. 

 

3.6. Настраиваем прерывания от CPU-таймера 0. Необходимо 

настроить три уровня прерывания. 

Первый уровень – модуль PIE, группа PIEIER1 (т.к. прерывания 

от CPU-таймера 0 относятся именно к данной группе, см. рис. 3.8): 

 
PieCtrlRegs.PIEIER1.bit.INTx7 = 1; 
 

 Второй уровень – разрешение прерываний линии 1 ядра ЦПУ.  

Для этого необходимо настроить регистр IER (см. рис. 3.2 и 3.3). 
 
IER = 1; 

 

Третий уровень – разрешить глобальные прерывания. Следует 
разрешить глобальные прерывания, добавив в программу команды:  

 
EINT;  
ERTM; 

 

Вызов данных подпрограммы следует произвести сразу вслед за 
конфигурацией таймера, произведенной в п. 3.6. 

 

3.7. Затем необходимо добавить команду запуска CPU Timer0: 

 
CpuTimer0Regs.TCR.bit.TSS = 0; 

 

3.8. Сразу после основной программы  (область 3 на рис. 3.16) 

необходимо добавить подпрограмму обработки прерываний от CPU-

таймера 0 «cpu_timer0_isr». Подпрограмму и обращение к ней 

мы уже внесли в программу. Теперь необходимо написать саму под-

программу. Подпрограмма  будет иметь общий вид: 

 
interrupt void cpu_timer0_isr(void) 
{ 
… 
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(текст подпрограммы) 
… 
} 

 

Подпрограмма должна выполнять следующие действия:  

- инкрементировать глобальную переменную «CpuTi-

mer0.InterruptCount», описываемую (начальное значение = 0) в подклю-

чаемом файле DSP281x_CpuTimers.c. Данная переменная будет показы-

вать истечение интервала времени 50 мс с момента запуска таймера;  
- сбросить  в «0» бит 1 регистра PIEACK, что необходимо для 

разрешения последующих прерываний. Это действие выполняет ко-

манда: 
 
PieCtrlRegs.PIEACK.all = PIEACK_GROUP1; 

 

3.9. После настройки таймера и прерываний корректируем ос-
новную программу. Для этого удаляем (либо добавляем в начале 
строки признак комментария «//»)  вызов подпрограммы   

«delay_loop(?);» (см. область 4 на рис. 3.16). Также удаляем 

объявление этой подпрограммы (см. область 5 на рис. 3.16), и заклю-

чаем в скобки комментария саму подпрограмму   

«void delay_loop(long end)». Скобки комментария открыва-
ются парой символов «/*» и закрываются парой символов «*/». 

Затем необходимо программно реализовать цикл ожидания для 

формирования задержки длительностью 150 мс, с учетом того, что 

переменная «CpuTimer0.InterruptCount» однократно инкрементируется 

в подпрограмме «interrupt void cpu_timer0_isr(void)» 

каждые 50 мс. Место вставки цикла ожидания – область 4  

на рис. 3.16. После цикла ожидания необходимо сбросить перемен-

ную «CpuTimer0.InterruptCount» в 0. 

 

3.10. Разрешаем работу Watchdog timer (WDT). См. область 6 на 
рис. 3.16. 

 

3.11. Добавляем обслуживание WDT. Для этого необходимо по-

следовательно записать в регистр WDKEY коды «0x55» и «0xAA», 

аналогично тому, как это выполнялось в программе к лабораторной 

работе № 2 (см. область 7 на рис. 3.16). Отличием является то, что 

данную процедуру вместе с макросами EALLOW и EDIS необходимо 
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перенести внутрь подпрограммы обработки прерывания от CPU-

таймера 0 «interrupt void cpu_timer0_isr(void)». По-

скольку прерывание от таймера происходит циклично с периодом   

50 мс, сброс ЦСП от WDT не происходит. 
 
4. Компиляция, компоновка и загрузка выходного файла в отла-

дочный модуль ЦСП. 
4.1. Компилируем программу: Project → Compile File. При нали-

чии ошибок, исправляем их. 
4.2. Компонуем проект: Project → Build. При наличии ошибок, 

исправляем их. 
4.3. Загружаем выходной файл: File → Load Program → Debug\ 

lab3.out (в случае, если данная функция сконфигурирована для вы-
полнения автоматически, выполнять данный пункт не нужно). 

 
 

Содержание отчета: 

 

Отчет должен содержать цель работы, краткие теоретические 
сведения по теме работы, тексты исследуемых программ, результаты 

их выполнения, выводы. 

 

Контрольные вопросы: 

 

1. Маскируемые и немаскируемые прерывания.  

2. Сброс ЦСП. 

3. Обработка прерываний ядра ЦСП семейства C28x. 

4. Назначение и структура модуля расширения прерываний (PIE) 

ЦСП семейства C28x. 

5. Расположение векторов прерываний ЦСП семейства C28x в 

режимах ENPIE=0 и ENPIE=1. 

6. Процедура обработки прерываний при ENPIE=1. 

7. Назначение и структура CPU-таймеров ЦСП семейства C28x. 

8. Регистры CPU-таймеров ЦСП семейства C28x. 

9. Какие изменения необходимо внести в исходный текст, чтобы 

программа «бегущие огни» выполнялась с движением «горя-

щих» светодиодов: 

- в 1,7 раз быстрее?  

- в 2,45 раз медленнее? 
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10. Какие изменения необходимо внести в исходный текст, чтобы 

программа «бегущие огни» выполнялась: 

- с замедлением движения «горящих» светодиодов в 2 раза на 
каждом шаге движения? 

- с ускорением движения «горящих» светодиодов в 3 раза на 
каждом шаге движения? 
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Лабораторная работа № 4 
Исследование модуля Менеджера Событий 

 
Цель работы: изучить аппаратные и программные возможности 

Менеджера Событий (Event Manager) DSP TMS320F2812. 
 

Теоретические сведения 
 

Структура Менеджера Событий 
 
Менеджер Событий (EV) включает в себя таймеры общего на-

значения (GP), устройства сравнения/ШИМ, устройства захвата, схе-
му квадратурного анализа (QEP). 

В сигнальном процессоре TMS320F2812 имеется два Менеджера 
Событий (EVA и EVB), которые выполняют аналогичные функции. 
EVA и EVB имеют идентичные регистры, расположенные по разным 
адресам.  

 

 
Рис. 4.1. Менеджер Событий 

 
Каждый Менеджер Событий управляется своей собственной ло-

гикой. Она может запрашивать прерывания. Менеджер Событий по-
зволяет запускать встроенный либо внешний аналого-цифровой пре-
образователь. Для запуска внешнего АЦП на выводах EVASOC или 
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EVBSOC (которые мультиплексируются с сигналами CTRIP2T  и 

CTRIP4T ), вырабатывается строб начала преобразования (SOC). 
На рис. 4.1 представлена функциональная схема модуля Менеджера Собы-

тий (EVA). 

Рассмотрим блоки EVM подробнее. 
 

Таймеры общего назначения  

 

В каждом модуле EVM имеется по два GP (General Purpose) тай-

мера общего назначения. В отличие от таймеров CPU, которые имеют 
разрядность 32-бита, таймеры Менеджера Событий являются незави-

симыми 16-разрядными устройствами, c расширенной системой вво-

да/вывода. Они могут работать независимо друг от друга или быть 
синхронизированными. 

 

 
Рис. 4.2.  Таймер общего назначения модуля EVM 

 

Центральным блоком GP таймера является блок сравнения. Здесь 

происходит сравнение значения 16-битного счетчика (TxCNT) с дву-

мя другими регистрами: регистром сравнения (TxCMPR) и регистром 

периода (TxPR). Если значения счетчика и регистра сравнения равны, 

то выходной формирователь устанавливает в «1» выходной сигнал 

(TxPWM). При достижении счетчиком значения регистра периода 
TxPWM сбрасывается.  
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Особенностью DSP TMS320F2812 является наличие буферов ре-
гистров TxCMPR и TxPR которые позволяют обновлять значения по 

заранее заданным событиям:  
а) достижение GP таймером-счетчиком нуля; 
б) достижение GP таймером-счетчиком значения, равного значе-

нию в регистре периода; 
в) немедленная загрузка после записи в буфер. 
 
Наличие буферов позволяет записывать новые значения в регист-

ры в любой момент времени, не дожидаясь окончания цикла. Загрузка 
значения из буфера в регистр периода происходит только при дости-

жении GP таймером-счетчиком нуля. 
Источником тактирования счетчика может являться: внешний 

сигнал (TCLKIN), тактовые импульсы от схемы квадратурного анали-
за (QEP) или тактовый сигнал от высокоскоростного предделителя 
(HSPCLK).  

В регистрах EVAIFRA, EVAIFRB, EVBIFRA, EVBIFRB имеются 
биты, отражающие флаги прерывания GP таймеров. Каждый из 4-х 
GP таймеров может вырабатывать  прерывание на следующие собы-
тия: 

а) достижение GP таймером-счетчиком нуля 0000h (TxUFINT); 
б) достижение максимального значения FFFFh (TxOFINT); 
в) достижение заданного значения сравнения (TxCINT); 
г) достижение значения, равного значению в регистре периода 

(TxPINT). 
 
Каждый GP таймер может работать  в одном из 4-х режимов. 
 
1) СТОП/Хранение. В этом режиме GP таймер останавливается и 

удерживает текущее значение, при этом таймер-счетчик, выходы 
сравнения и значение предделителя остаются без изменения. Если же 
остановить таймер, просто запретив его работу, то счетчик будет 
сброшен и значение предделителя установится в х/1. 

2) Непрерывный режим счета вверх. В этом режиме значение 
счетчика увеличивается до тех пор, пока не достигнет значения, рав-
ного значению в регистре периода (рис. 4.3). После этого счетчик 
сбрасывается в ноль и начинает считать сначала. При этом вырабаты-
вается флаг прерывания, который остается установленным в течение 
одного такта. Если флаг не был маскирован, то вырабатывается за-
прос прерывания от периферийного устройства. 
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Рис. 4.3. Режим непрерывного счета вверх GP таймера  
 

Продолжительность периода равна (TxPR)+1, за исключением 

первого периода, который может быть произвольным, так как началь-

ное значение в счетчике может быть любым от 0000h до FFFFh. 

Если исходное значение  больше, чем значение в регистре пе-
риода, то таймер досчитает до FFFFh, сбросится в ноль и продолжит 
работать так, как если бы исходное значение было равно нулю. При 

достижении счетчиком значения, равного значению в регистре перио-

да, устанавливается флаг прерывания по периоду, происходит сброс в 

ноль и устанавливается флаг прерывания по нулю. 

Если исходное значение в счетчике находится между нулем и 

значением в регистре периода, то таймер сначала досчитает до значе-
ния в регистре периода, а затем будет работать так, как был запро-

граммирован. 

3) Управляемый режим счета вверх/вниз. В этом режиме на-
правление счета зависит от состояния входа TDIRA/B: вверх, если 

сигнал на TDIRA/B высокого уровня; вниз – низкого. 

 

 
 

Рис. 4.4. Режим управляемого счета вверх/вниз GP таймера 
 

4) Непрерывный режим счета вверх/вниз. В отличие от преды-
дущего режима, направление счета изменяется при достижении нуля 
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или значения в регистре периода. Продолжительность периода в этом 
режиме равна 2·(TxPR). 

 

 
 

Рис. 4.5. Непрерывный режим счета вверх/вниз 
 

Устройство захвата (Capture Unit) предназначено для опреде-
ления временных параметров внешних сигналов. Значение выбранно-
го GP таймера захватывается и запоминается в 2-уровневом стеке 
FIFO, когда на соответствующих выводах фиксируется заданный пе-
репад уровней. Устройство захвата состоит из 3-х цепей CAPx (x=1, 2 
или 3 для EVA; x=4, 5 или 6 для EVB). 

Устройство захвата обладает следующими особенностями: 
1) имеется один 16-разрядный регистр управления захватом (CAP-
CONx); 
2) имеется один 16-разрядный регистр статуса FIFO (CAPFIFOx); 
3) в качестве тактирования можно использовать любой GP таймер; 
4) все входы синхронизируются таймерами CPU; 
5) пользователь сам устанавливает, по какому уровню осуществлять 
захват; 
6) имеется 3 маскируемых флага прерывания. 

Входы CAP 1/2 и CAP 4/5 также могут быть использованы как 
входы схемы квадратурного анализа. 

Устройство сравнения. В каждом EVM предусмотрено по 3 
устройства сравнения (Compare Unit). Эти устройства используют GP 
таймер 1 в качестве синхронизатора, и могут вырабатывать до 6 вы-
ходных сигналов сравнения (ШИМ-сигналов). Все 6 выходов работа-
ют независимо друг от друга. Регистры сравнения дублируются, по-
зволяя фиксировать изменения ширины импульсов. Они позволяют 
снизить до минимума программную загрузку ядра при операциях из-
мерений длительности, периодических выборок и генерации сигналов 
ШИМ.  
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Схема квадратурного анализа используется для подключения 
энкодера – оптического преобразователя направления и скорости 
вращения. Выходными сигналами энкодера являются два сигнала ти-
па меандр, по частоте и фазовым сдвигам которых можно определить 
направление и скорость вращения. Схема QEP по этим сигналам фор-
мирует два сигнала: логический сигнал направления вращения (DIR) 
и частотный сигнал скорости вращения (CLK)  

 

Формат регистров модуля Менеджера Событий 
 

Регистр счетчика GP таймера (TхCNT)  

 15                                                                                                                 0 

TхCNT 

R/W - x 
 

Биты Название Описание 
15:0 T1CNT Мгновенное значение таймера-счетчика 1 

 

Рис. 4.6. Формат регистра счетчика GP таймера. 
 

Регистр сравнения GP таймера (TхCMPR) 

15  0 

 T1CMPR  

R/W - x 
 

Биты Название Описание 
15:0 T1CMPR Хранимое значение сравнения таймера-

счетчика 1 
 

Рис. 4.7. Формат регистра сравнения GP таймера  
 

Регистр периода GP таймера (TхPR) 

15  0 

 T1PR  

R/W - x 

 

Биты Название Описание 
15:0 T1PR Хранимое значение периода таймера-счетчика 

1 

Рис. 4.8. Формат регистра периода GP таймера  
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Рис. 4.9. Регистры управления таймером (TхCON) 
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Рис.  4.10. Регистр А управления GP таймером (GPTCONA) 
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Рис. 4.11. Формат регистра А маски прерываний (EVAIMRA) 

 

 

 

 

 

 
 

Рис. 4.12. Формат регистра B маски прерываний (EVAIMRB) 
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Рис. 4.13. Формат регистра C маски прерываний (EVAIMRC) 

 

 

 
 

Рис. 4.14. Формат регистров флагров прерываний 

 

 

Прерывания Менеджера Событий 

 

Если от какого-либо периферийного устройства пришло преры-

вание, то в регистрах EVxIFRA, EVxIFRB или EVxIFRC (x=A или B) 

устанавливается соответствующий флаг.  
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Прерывания Менеджера Событий могут быть индивидуально 

разрешены/ запрещены с помощью маскирования прерываний в реги-

страх EVxIMRA, EVxIMRB или EVxIMRC. Бит, установленный в 1 

разрешает (не маскирует) прерывания, сброшенный в 0 – запрещает 
(маскирует). Если установлены биты флага и маскирования прерыва-
ния, то в модуль PIE (Peripheral Interrupt Expansion) отправляется за-
прос на прерывание. Логика PIE записывает все запросы прерывания 

и вырабатывает прерывание CPU. 

При получении от INT 1, 2, 3, 4 или 5 запроса прерывания, уста-
навливается соответствующий бит в регистре флага прерывания CPU 

(IFR). Если соответствующий бит регистра маскирования прерываний 

(IER) установлен и сброшен бит INTM, то CPU признает прерывание. 
Далее CPU завершает выполнение текущей инструкции и переходит 
на адрес вектора прерываний соответственно INT 1.y, 2.y, 3.y, 4.y, 5.y 

в таблице вектора PIE. В это время сбрасывается бит IFR и устанав-

ливается бит INTM, запрещая очередное прерывание. 
Вывод и прерывание PDP (power drive protect) предназначены для 

защиты внешнего силового преобразователя от перегрузок, в т.ч. от 
коротких замыканий. Функция PDP позволяет защитить внешние си-

ловые устройства при системных сбоях. 

 

Примеры использования менеджера событий.  

 

Менеджер событий предназначен для формирования управляю-

щих сигналов и для определения временных характеристик внешних 

информационных сигналов. Наличие специализированного аппарат-
ного модуля позволяет разгрузить ЦПУ для других задач. Одно из 
применений TMS320F2812  - системы электропривода. Для  форми-

рования ШИМ – сигналов специальной формы (например, синусои-

дального) используют один из двух методов. 

Первый метод предполагает вычисление функции синуса, которая 

входит в библиотеку «math.lib». Для этого в проект включается заго-

ловочный файл «math.h», который позволяет обратиться к библиотеке 
математических функций. Но функция синуса в библиотеке «math.lib» 

– это функция с плавающей запятой и для её реализации на процессо-

ре F2812, работающего с фиксированной запятой, потребуется много 

времени. 

Второй метод основан на работе с таблицей, в которую предвари-

тельно занесены рассчитанные значения функции. Этот метод еще на-
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зывают «доступ к поисковой таблице» («Lookup Table Access»). Элек-

тронные устройства контроля используют такие таблицы не только 

для вычисления тригонометрических функций, но и для определения 

параметров управления. Доступ ячейкам таблицы осуществляется бы-

стро, всего за несколько тактов можно определить требуемое значе-
ние функции. Увеличить точность вычисления функций можно, при-

менив аппроксимацию.  Таблица может быть как одномерной (выход-

ная величина зависит от одного параметра), так и многомерной (вы-

ходная величина  - функция двух и более переменных). Чем больше 
число ячеек таблицы, тем точнее аппроксимация исходной функции. 

В ПЗУ процессора TMS320F2812 уже размещена таблица синусои-

дальной функции. Таблица использует дробно-целочисленный фор-

мат с фиксированной запятой IQ, или Q. Таблица представлена в 

формате Q30. Это означает, что 30 младших бит представляют дроб-

ную часть числа, один – целую и старший – знак числа.   
 

 

Порядок выполнения лабораторной работы  

 

Часть I. Формирование сигналов звуковой частоты 

 при помощи прямоугольных импульсов 

 

В работе необходимо сгенерировать звуковую гамму (звуковой 

ряд) используя динамик, соединенный с выходом T1PWM. В первой 

части лабораторной работы звучание организуется при помощи пря-

моугольных импульсов, генерируемых таймером Менеджера Собы-

тий. Каждая нота будет воспроизводиться 500 мс. Загрузка новой но-

ты будет производиться по прерыванию таймера ЦПУ 0. Период тай-

мера ЦПУ – 50 мс. В подпрограмме обслуживания прерываний от 
ЦПУ таймера 0 необходимо производить сброс Watchdog  и загружать 
новую ноту. Обратите внимание на период между прерываниями тай-

мера, периодом Watchdog и периодом перезагрузки новой ноты.  

 

Таблица. Соответствие частот музыкальным нотам 
Нота С1 

D E F G A H C
2 

Частота, Гц 264 297 330 352 396 440 495 528 

 

1. Создание нового проекта. 
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В Code Composer Studio создаем новый проект Lab5.pjt. Открыва-
ем файл Lab4.c и сохраняем его E:\C281x\Labs\Lab5\lab5.c.  

Добавляем в проект файлы: 

C:\tidcs\c28\dsp281x\v100\DSP281x_headers\source\DSP281x_GlobalVar

iableDefs.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\cmd\F2812_EzDSP_R

AM_lnk.cmd; 

C:\tidcs\c28\dsp281x\v100\DSP281x_headers\cmd\F2812_Headers_n

onBIOS.cmd; 

C:\ti\c2000\cgtools\lib rts2800_ml.lib; 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\source: 

DSP281x_CpuTimers.c, DSP281x_PieCtrl.c, DSP281x_PieVect.c, 

DSP281x_DefaultIsr.c. 

 
 
//########################################################### 
// Имя файла: lab4_.c 
// 
// Описание: Выработка прямоугольных импульсов. Воспроизве-
дение  
//   гаммы через динамик, подключенный к выводу T1PWM  
//   (GPIO A6). Длительность звучания каждой ноты 0,5 с.  
//   Выработка прерываний CPU - таймером 0 каждые 50 мс. 
//  Сброс сторожевого таймера каждые 0,2 с.  
//########################################################### 
 
#include "DSP281x_Device.h"    
 
void Gpio_select(void); 
void InitSystem(void); 
interrupt void cpu_timer0_isr(void);   // Подпрограмма обработки 
прерываний от  
// CPU - таймера 0 
 
void main(void) 
{ 
 unsigned int i;        
 unsigned long time_stamp;  // Временная фиксация 
 int frequency[8]={2219,1973,?,?,?,?,?,?}; 
   
 InitSystem();  // Инициализация регистров ЦСП 
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 Gpio_select();  // Инициализация линий ввода/вывода 
 InitPieCtrl();  // Вызов подпрограммы инициализации 
блока PIE  
 InitPieVectTable(); // Вызов подпрограммы инициализации таб-
лицы  
      // векторов блока PIE  
 
 EALLOW;   
    PieVectTable.TINT0 = &cpu_timer0_isr; 
    EDIS;     
 
 InitCpuTimers(); 
  
 // Настройка CPU - таймера 0: частота 150 МГц, период преры-
вания 50 мс  
 ConfigCpuTimer(&CpuTimer0, 150, 50000);  
 
    // Разрешение прерывания от CPU - таймера 0, группа 1, прерыва-
ние 7 
    PieCtrlRegs.PIEIER1.bit.INTx7 = 1; 
 
 IER = 1;   // Разрешение прерываний линии 1 (INT1) 
    EINT;      // Общее разрешение прерываний INTM 
    ERTM;      // Разрешение общих прерываний в режи-
ме 
      // реального времени  
     
 EALLOW;   
    // Настройка модуля Менеджера Событий A 
    EvaRegs.GPTCONA.bit.TCMPOE = ?;  // Управление логикой 
сравнения  
          // T1PWM / 
T2PWM 
    // Полярность выходов сравнения таймера 1: активный уровень - 
низкий  
 EvaRegs.GPTCONA.bit.T1PIN = ?; 
 // Режим счета вверх таймера-счетчика модуля Менеджера Со-
бытий  
 EvaRegs.T1CON.all = 0x????;          
            
    CpuTimer0Regs.TCR.bit.TSS = ?; // Запуск CPU - таймера 0 
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    EDIS;     
 
    i = 0; 
    time_stamp = 0; 
     
 while(1) 
 {     
       if ((CpuTimer0.InterruptCount%4)==0)// Деление значения 
счетчика  
           // на 4 без 
остатка 
        { 
       EALLOW; 
      SysCtrlRegs.WDKEY = 0xAA;    
      EDIS; 
        } 
        if ((CpuTimer0.InterruptCount - time_stamp)>10) 
      {   
      time_stamp = CpuTimer0.InterruptCount; 
      if(i<7) EvaRegs.T1PR = frequency[i++]; 
      else   EvaRegs.T1PR = frequency[14-i++];  
 
         EvaRegs.T1CMPR = EvaRegs.T1PR/2;  
         EvaRegs.T1CON.bit.TENABLE = 1;  // Разрешение 
работы  
           // 
таймера модуля EVA 
         if (i>=14) i=0; 
     } 
 } 
}   
 
//########################################################### 
// Подпрограмма: Gpio_select 
// 
// Описание: Настройка линий порта GPIO B15-8 на ввод, а линий 
B7-0 //  на вывод. Настройка всех линий портов A, D, F, E, G 
на  
//  ввод. Запрещение работы входного ограничителя 
//########################################################### 
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void Gpio_select(void) 
{ 
    EALLOW; 
    GpioMuxRegs.GPAMUX.all = ?;   // Настройка линий 
ввода/вывода на                            
    GpioMuxRegs.GPBMUX.all = 0x0;  // работу в качестве пор-
тов    
    GpioMuxRegs.GPDMUX.all = 0x0; 
    GpioMuxRegs.GPFMUX.all = 0x0;    
    GpioMuxRegs.GPEMUX.all = 0x0;  
    GpioMuxRegs.GPGMUX.all = 0x0;    
           
    GpioMuxRegs.GPADIR.all = 0x0;  // Настройка портов А, D, 
E, F, G на ввод 
    GpioMuxRegs.GPBDIR.all = 0x00FF; // Настройка линий порта B 15-
8 на ввод,  
    GpioMuxRegs.GPDDIR.all = 0x0;  // а линий 7-0 на вывод 
    GpioMuxRegs.GPEDIR.all = 0x0;  
    GpioMuxRegs.GPFDIR.all = 0x0;  
    GpioMuxRegs.GPGDIR.all = 0x0;  
 
    GpioMuxRegs.GPAQUAL.all = 0x0;  // Запрещение входного 
ограничителя 
    GpioMuxRegs.GPBQUAL.all = 0x0; 
    GpioMuxRegs.GPDQUAL.all = 0x0; 
    GpioMuxRegs.GPEQUAL.all = 0x0; 
    EDIS; 
}      
 
//########################################################### 
// Подпрограмма: InitSystem 
// 
// Описание: Настройка сторожевого таймера на работу, 
//  предделитель = 1. Выработка сброса сторожевым  
//  таймером. Внутренняя частота работы ЦСП 150 МГц. 
//  Запись в предделитель высокоскоростного таймера  
//  коэффициента деления 2, а в предделитель 
//  низкоскоростного таймера - 4. Запрещение работы  
//  периферийных устройств 
//########################################################### 
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void InitSystem(void) 
{ 
    EALLOW; 
    SysCtrlRegs.WDCR= 0x00AF;  // Разрешение работы сто-
рожевого           // таймера, 
предделитель = 64 
         // 0x00E8 - запреще-
ние работы  сторо- 
         // жевого таймера, 
предделитель = 1 
  
    SysCtrlRegs.SCSR = 0;    // Выработка сброса WDT
  
    SysCtrlRegs.PLLCR.bit.DIV = 10; // Настройка блока умножения 
частоты 
    SysCtrlRegs.HISPCP.all = 0x1;  // Задание значения преддели-
теля высо- 
    SysCtrlRegs.LOSPCP.all = 0x2;  // коскоростного и низкоскоро-
стного  
         // таймеров       
 
    // Разрешение / запрещение тактирования периферийных устройств 
    SysCtrlRegs.PCLKCR.bit.EVAENCLK = ?; 
    SysCtrlRegs.PCLKCR.bit.EVBENCLK = 0;  
    SysCtrlRegs.PCLKCR.bit.SCIAENCLK = 0; 
    SysCtrlRegs.PCLKCR.bit.SCIBENCLK = 0; 
    SysCtrlRegs.PCLKCR.bit.MCBSPENCLK = 0; 
    SysCtrlRegs.PCLKCR.bit.SPIENCLK = 0; 
    SysCtrlRegs.PCLKCR.bit.ECANENCLK = 0; 
    SysCtrlRegs.PCLKCR.bit.ADCENCLK = 0; 
 
    EDIS; 
} 
 
//########################################################### 
// Подпрограмма: cpu_timer0_isr  
// 
// Описание:  Обработка прерывания по CPU - таймеру 0 
//########################################################### 
 
interrupt void cpu_timer0_isr(void) 
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{ 
    CpuTimer0.InterruptCount++; 
 
    EALLOW; 
 SysCtrlRegs.WDKEY = 0x55;  // Сброс сторожевого 
таймера 
 EDIS; 
 
 // Подтверждение прерывания от группы прерываний 1 
 PieCtrlRegs.PIEACK.all = PIEACK_GROUP1;  
} 
 
 
 

Рис. 4.15. Структура текста программы 
 

 2. Настройка параметров проекта, компоновка проекта и загруз-
ка выходного файла. 

Включаем в проект заголовочные файлы: Project →  Build 

Options, в закладке Compiler выбираем Preprocessor и в поле Include 

Search Path (-i) вводим: 

C:\tidcs\C28\dsp281x\v100\DSP281x_headers\include;..\include 

 Задаем глубину стека: Project → Build Options → Linker → Stack 

Size: 0x400. 

 Компонуем проект: Project → Build.  

Загружаем выходной файл: File → Load Program → Debug\ 

lab5.out. 

 

3. Преобразование файла Lab5.c. 

Удаляем те части программы, которые не будут использоваться 

данной лабораторной работе: массив LED[8]. 

Переходим к подпрограмме «Gpio_select()». Настраиваем линию 

6 порта GPIOA на вывод функции T1PWM (GPАMUX). 

В подпрограмме «InitSystem» разрешаем работу Менеджера Со-

бытий А. 

Внутри главной подпрограммы записываем:  

CpuTimer0Regs.TCR.bit.TSS = 0. 

 Настраиваем таймер 1 Менеджера Событий на выработку моду-

лированного сигнала PWM: 
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 Бит «TCMPOE» устанавливаем в 1, задаем “активный низкий” 

уровень (GPTCONA); 

 В регистре T1CON устанавливаем: режим счета вверх (TMODE), 

делитель 128 (TPS), запрещаем работу таймера (TENABLE), выбира-
ем внутреннюю синхронизацию (TCLKS), разрешаем сравнение 
(TECMPR); 

 Определяем значения регистра периода (T1PR) для разных час-
тот и заносим их в массив int frequency [8] = {?,?,?,?,?,?,?,?}. Исходя из 
формулы T1_PWM_Freq = 150MHz / (HISPCP * TPS * T1PR) для 

первой ноты в регистр периода необходимо занести: T1PR = 150MГц / 

(2 * 128 * 264 Гц) = 2219, для второй ноты T1PR = 150MГц / (2 * 128 * 

297 Гц) = 1973 и т.д. 

 Так как сторожевой таймер будет сбрасываться быстрее (каж-

дые 200 мс), чем прозвучит следующая нота (через 500 мс), то задаем 

условия: 
if ((CpuTimer0.InterruptCount%4)= =0)  

SysCtrlRegs.WDKEY = 0xAA 

  Разбиваем период воспроизведения нот на 10 периодов по 50 

мс, для этого записываем условие: if ( (CpuTimer0.InterruptCount – 

time_stamp ) > 10). 

После чего переменной «time_stamp» присваиваем текущее зна-
чение CpuTimer0.InterruptCount, загружаем код следующей ноты в 

T1PR, а в регистр T1CMPR заносим значение, равное T1PR/2. Разре-
шаем работу таймера. 
 
//########################################################### 
// Имя файла: _lab5А_.c 
// 
// Описание: Выработка синусоидальных колебаний на выводе 
T1PWM  
//   (GPIO A6). Выработка прерываний CPU - таймером 0  
//   каждые 50 мс. Сброс сторожевого таймера каждые 0,2 с.  
//########################################################### 
  
#include "DSP281x_Device.h"      
#include "IQmathLib.h"    // Включение математиче-
ских библиотек 
#pragma DATA_SECTION(sine_table,"IQmathTables"); 
_iq30 sine_table[512]; 
 



 67

void Gpio_select(void); 
void InitSystem(void);    
interrupt void T1_Compare_isr(void); // Подпрограмма обработки 
прерываний 
          // таймера сравне-
ния 1 EVA  
int Count = 0; 
 
void main(void) 
{ 
 InitSystem();  // Инициализация регистров ЦСП 
 Gpio_select();  // Инициализация линий ввода/вывода 
 InitPieCtrl();  // Инициализации блока PIE  
 InitPieVectTable(); // Инициализация таблицы векторов блока 
PIE  
 
 EALLOW;   
    PieVectTable.T1CINT = &T1_Compare_isr; 
    EDIS;     
 
 // Разрешение прерывания от таймера сравнения 1, группа 2, 
прерывание 5 
    PieCtrlRegs.PIEIER2.bit.INTx5 = 1; 
 
 IER = 2;   // Разрешение прерываний линии 2 (INT2) 
    EINT;      // Общее разрешение прерываний INTM 
    ERTM;      // Разрешение общих прерываний в режи-
ме 
      // реального времени  
 
 // Настройка модуля Менеджера Событий A 
 
    EvaRegs.GPTCONA.bit.TCMPOE = ?;  // Управление логикой 
сравнения  
          // T1PWM / 
T2PWM 
    // Полярность выходов сравнения GP таймера 1: активный уро-
вень - низкий  
 EvaRegs.GPTCONA.bit.T1PIN = ?; 
 



 68

 EvaRegs.T1CON.bit.FREE = ?;  // Биты управления эму-
лятором: 
   EvaRegs.T1CON.bit.SOFT = ?;  // мгновенная остановка 
    EvaRegs.T1CON.bit.TMODE = ?; // Непрерывный счет вверх  
    EvaRegs.T1CON.bit.TPS = ?;  // Предделитель = 1 : 75 МГц 
    EvaRegs.T1CON.bit.TENABLE = ?; // Запрещение работы GP тай-
мера 1 
    EvaRegs.T1CON.bit.TCLKS10 = ?; // Внутренний источник 
тактирования 
    EvaRegs.T1CON.bit.TCLD10 = ?; // Перезагрузка GP таймера   
         // при достижении 
нуля 
    EvaRegs.T1CON.bit.TECMPR = ?; // Разрешение режима 
сравнения 
                                           
    EvaRegs.T1PR = 1500;   // Регистр периода GP 
таймера 
 
    EvaRegs.T1CMPR = EvaRegs.T1PR/2;   
     
    EvaRegs.EVAIMRA.bit.T1CINT = ?; // Разрешение прерывания 
при  
         // достижении зна-
чения сравнения 
    EvaRegs.T1CON.bit.TENABLE = ?; // Разрешение работы GP 
таймера 1 
     
 while(1) 
    {     
       EALLOW; 
     SysCtrlRegs.WDKEY = 0xAA;    
     EDIS; 
       } 
}   
 
//########################################################### 
// Подпрограмма: T1_Compare_isr 
// 
// Описание:  Обработка прерывания по GP таймеру 1 
//########################################################### 
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interrupt void T1_Compare_isr(void) 
{ 
    static int index=0; 
     
    Count++;      
     
    EALLOW; 
 SysCtrlRegs.WDKEY = 0x55;   
 EDIS; 
 
   EvaRegs.T1CMPR =  EvaRegs.T1PR -
_IQsat(_IQ30mpy(sine_table[index]+_IQ30(0.9999),EvaRegs.T1PR/2),Ev
aRegs.T1PR,0); 
 
    index +=4;            // Использование каждого 4-го значения 
таблицы 
 if (index >511) index = 0; 
     
   // Сброс флага прерывания GP таймера сравнения 
    EvaRegs.EVAIFRA.bit.T1CINT = 1; 
    
 // Подтверждение прерывания от группы прерываний 2 
 PieCtrlRegs.PIEACK.all = PIEACK_GROUP2; 
} 
 
//########################################################### 
// Подпрограмма: Gpio_select 
// 
// Описание: Настройка линий порта GPIO B15-8 на ввод, а линий 
B7-0 //  на вывод. Настройка всех линий портов A, D, F, E, G 
на  
//  ввод. Запрещение работы входного ограничителя 
//########################################################### 
 
void Gpio_select(void) 
{ 
 EALLOW; 
 GpioMuxRegs.GPAMUX.all = ?; // Настройка линий вво-
да/вывода на                            
 // Настройка линии порта GPIO A6 на работу в качестве специ-
альной  
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 // функции (T1PWM) - вывод прямоугольных импульсов 
 
    GpioMuxRegs.GPBMUX.all = 0x0; // работу в качестве портов    
    GpioMuxRegs.GPDMUX.all = 0x0; 
    GpioMuxRegs.GPFMUX.all = 0x0;    
    GpioMuxRegs.GPEMUX.all = 0x0;  
    GpioMuxRegs.GPGMUX.all = 0x0;    
           
    GpioMuxRegs.GPADIR.all = 0x0; // Настройка портов А, D, E, F, 
G на ввод 
 GpioMuxRegs.GPBDIR.all = 0x00FF; // Настройка линий 15-8 
на ввод, а линий  
    GpioMuxRegs.GPDDIR.all = 0x0;  // 7-0 на вывод 
    GpioMuxRegs.GPEDIR.all = 0x0;  
    GpioMuxRegs.GPFDIR.all = 0x0;  
    GpioMuxRegs.GPGDIR.all = 0x0;  
 
    GpioMuxRegs.GPAQUAL.all = 0x0; // Запрещение входного огра-
ничителя 
    GpioMuxRegs.GPBQUAL.all = 0x0; 
    GpioMuxRegs.GPDQUAL.all = 0x0; 
    GpioMuxRegs.GPEQUAL.all = 0x0; 
    EDIS; 
}      
 
//########################################################### 
// Подпрограмма: InitSystem 
// 
// Описание: Настройка сторожевого таймера на работу, 
//  предделитель = 1. Выработка сброса сторожевым  
//  таймером. Внутренняя частота работы ЦСП 150 МГц. 
//  Запись в предделитель высокоскоростного таймера  
//  коэффициента деления 2, а в предделитель 
//  низкоскоростного таймера - 4. Запрещение работы  
//  периферийных устройств 
//########################################################### 
 
void InitSystem(void) 
{ 
    EALLOW; 
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    SysCtrlRegs.WDCR= 0x00AF;  // Разрешение работы сто-
рожевого        // таймера, предделитель = 64 
 // 0x00E8 - запрещение работы  сторожевого таймера,  
 // предделитель = 1 
     SysCtrlRegs.SCSR = 0;   // Выработка сброса WDT  
    SysCtrlRegs.PLLCR.bit.DIV = 10; // Настройка блока умножения 
частоты 
    SysCtrlRegs.HISPCP.all = 0x1;  // Задание значения преддели-
теля высо- 
    SysCtrlRegs.LOSPCP.all = 0x2;  // коскоростного и низкоскоро-
стного таймеров      
    SysCtrlRegs.PCLKCR.bit.EVAENCLK=?; // Запрещение рабо-
ты периферийных устройств 
    SysCtrlRegs.PCLKCR.bit.EVBENCLK=0;   
    SysCtrlRegs.PCLKCR.bit.SCIAENCLK=0; 
    SysCtrlRegs.PCLKCR.bit.SCIBENCLK=0; 
    SysCtrlRegs.PCLKCR.bit.MCBSPENCLK=0; 
    SysCtrlRegs.PCLKCR.bit.SPIENCLK=0; 
    SysCtrlRegs.PCLKCR.bit.ECANENCLK=0; 
    SysCtrlRegs.PCLKCR.bit.ADCENCLK=0; 
    EDIS; 
} 
 
 

Рис. 4.16. Структура текста программы 
 

 4. Тестирование программы.  

Сбрасываем ЦСП: Debug → Reset CPU, Debug → Restart. 

 Переходим к главной подпрограмме: Debug → Go main. 

Запускаем программу: Debug → Run.  

 

Часть II. Формирование сигналов звуковой частоты 

 при помощи синусоидальных импульсов 

 

Во второй части работы необходимо вывести синусоидальный 

ШИМ - сигнал. Отметим, что музыкальная нота – это гармоническое 
синусоидальное колебание определенной частоты, поэтому, изучив 

принцип получения синусоидальных колебаний, можно получить 

чистоту звучания нот, близкую к реальности. В таблице представлено 

соответствие частот и нот музыкального звукоряда. 
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Для расчета частоты синусоидальных колебаний  используется 

формула:  

ШИМ

ШИМ
sin

N

f
f   (4.1) 

 

где ШИМf - частоты модулированных импульсов; 

       ШИМN - число модулированных импульсов за период. 

 

1. Создание нового проекта. 
1.1 Создаем новый проект Lab5А.pjt.  

1.2 Добавляем в проект файлы (см. п. 1.2 части I), кроме файла  
DSP281x_CpuTimers.c, и вместо lab5.c загружаем lab5А.c. 

 

 2. Настройка параметров проекта, компоновка проекта и загруз-
ка выходного файла (аналогично п.п. 2.1 – 2.4 части I данной лабора-
торной работы). В  закладке Compiler выбираем Preprocessor и в поле 
Include Search Path (-i) вводим:   

C:\tidcs\C28\dsp281x\v100\DSP281x_headers\include; 

..\include; C:\tidcs\C28\IQmath\cIQmath\include 

 

3. Преобразование файла Lab5А.c. 

Удаляем те строки программы, которые касаются работы тайме-
ра 0 ядра процессора F2812: ConfigCpuTimer(&CpuTimer0, 
150, 50000), InitCpuTimers(), CpuTi-

mer0Regs.TCR.bit.TSS = 0, переменные i и time_stamp, массив 

frequency [8]. 

Переименовываем подпрограмму “cpu_timer0_isr()” в 

“T1_Compare_isr” и в ней добавляем строку: 

PieCtrlRegs.PIEACK.all = PIEACK_GROUP2, устанавливаем 

бит T1CINT регистра EVAIFRA в 1. 

Добавляем инструкцию, разрешающую в модуле расширения 

прерываний PIE прерывание от GP таймера 1: 

PieCtrlRegs.PIEIER2.bit.INTx5=1 и устанавливаем разреше-
ние прерывания ядра процессора INT2: IER = 2. 

 Настраиваем таймер 1 Менеджера Событий (аналогично пп. 

3.5.1 – 3.5.2 части I): записываем коэффициент деления равный 1, ус-
танавливаем бит T1CINT регистра EVAIMRA в 1. 
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 В регистр периода (T1PR) заносим значение, рассчитанное по 

формуле: 

HISCPTPSPR1T

f
f

1T

CPU

PWM 
  (4.2) 

  

где 50f PWM   кГц, 150fCPU   МГц,HISCP = 2, TPS = 1. 

 

 

 

 

 

 
 

Рис. 4.17. Принцип формирования синусоидального сигнала  
широтно-импульсной модуляцией  

  

4. Тестирование программы.  

Сбрасываем ЦСП: Debug → Reset CPU, Debug → Restart. 

 Переходим к главной подпрограмме: Debug → Go main. 

Запускаем программу: Debug → Run.  

Устанавливаем точку останова на строчке: 
PieCtrlRegs.PIEACK.all = PIEACK_GROUP2. 

 

5. Включение библиотеки “IQ-Math” в проект. 
Добавляем в начальную часть текста программы строки: 

 #include "IQmathLib.h",  
_iq30 sine_table[512], 
 #pragma DATA_SECTION(sine_table,"IQmathTables");  

и добавляем файл Lab5A.cmd. 

 

6. Расчет необходимого значения регистра сравнения. 

Учитывая, что разность значений регистра периода и регистра 
сравнения определяет ширину выходного модулированного импульса 
(см. рис. 4.15), а значения функции синуса изменяются от минус 1 до 

плюс 1, рассчитываем значение регистра сравнения по формуле: 
 

T1CMPR = T1PR – _IQ30mpy(sine_table[index] + 

_IQ30(0.9999),T1PR/2) 
(4.3) 

 

T 
t 
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где функция IQ30mpy(a, b) – умножение чисел a и b в формате 
IQ30;  _IQ30(0.9999) – оттранслированное значение единицы. 

 

 

 
 

Рис. 4.18. Изменение ширины импульса при ШИМ по  

синусоидальному закону 

 

Чтобы избежать переполнения, применим функцию насыщения 

_IQsat (x, max, min). Тогда окончательно записываем в подпрограмму 

T1_Compare_isr формулу для расчета необходимого значения регист-
ра сравнения: 
EvaRegs.T1CMPR = EvaRegs.T1PR - 
_IQsat(_IQ30mpy(sine_table[index]+_IQ30(0.9999),      
EvaRegs.T1PR/2),EvaRegs.T1PR,0). 

 

7. Расчет частоты синусоидальных колебаний. 

Для этого используем формулу (1), задаемся ШИМf = 50 кГц, 

ШИМN = 128, т.е. из таблицы значений синуса выбираем каждое чет-
вертое число, добавляем строку: 

 index += 4.  

 

Тогда  sinf = 390,6 Гц. 

Компонуем проект: Project → Rebuild All. 

 

 

 

T1PR 

 

 

 

T1PR/2 

 

 

 

0 

 

 

 

T1PWM_

T1CMP 

T1CMPR 

T1CNT 
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Содержание отчета: 

 

Отчет должен содержать цель работы, краткие теоретические сведе-
ния по теме работы, рисунки, поясняющий принцип формирования 

ШИМ – сигналов, тексты исследуемых программ,  результаты их вы-

полнения, выводы. 

 

 

Контрольные вопросы: 

 

1.  Назначение и структура Менеджера Событий DSP 

TMS320F2812. 

2.  Структура таймеров Менеджера Событий, их отличие от тай-

меров ЦПУ по структуре и назначению.  

3.  Режимы работы таймеров Менеджера Событий. 

1. Регистры Менеждера Событий. 

2. ШИМ – сигнал: определение, формирование с помощью Ме-
неджера Событий. 

3. Прерывания Менеджера Событий. 
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Лабораторная работа № 5 
 Исследование модуля АЦП 

 
Цель работы: изучить структуру встроенного АЦП, режимы 

его работы. Научится создавать простейшие программы с использо-
ванием АЦП. 

 
Теоретические сведения 

 
Структура модуля АЦП 

 

 Модуль АЦП содержит ядро АЦП, два устройства выборки – 

хранения, аналоговый мультиплексор, мультиплексор УВХ, мультип-

лексор результата и автоматический секвенсер (устройство управле-
ния работой АЦП и мультиплексоров). 12- битный АЦП имеет 16 

мультиплексированных входов. АЦП может работать либо в каскад-

ном, либо в двухканальном режимах. 

 

 
 

Рис. 5.1. Блок-схема модуля АЦП в каскадном режиме 
 

Структура АЦП в каскадном режиме представлена на рис. 5.1. 

Как видно из рисунка, в этом режиме работой модуля управляет один 

автоматический секвенсер. Перед запуском необходимо задать число 

преобразований  (“MAX_CONV1”) и номер канала, который будет 
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преобразован на каждом шаге (“CHSELxx”). Результат преобразова-
ния на каждом шаге сохраняется в соответствующий регистр (“RE-

SULT0” to “RESULT15”).  

Можно задать два режима захвата сигналов – одновременный и 

последовательный. В первом случае два УВХ работают в параллель, 

т.е. выборка и захват происходят одновременно. При этом за один 

шаг осуществляется преобразование двух каналов различных групп с 
одинаковым кодом (например, ADCINA3 и ADCINB3). В последова-
тельном режиме сигнал с любого входа может быть преобразован на 
любом шаге. Запуск преобразования может осуществляется про-

граммно, от внешнего источника или от менеджеров событий А или 

В. Запуск от Менеджера Событий осуществляется аппаратно, без ис-
пользования прерываний, что позволяет очень точно задавать интер-

вал преобразования. Прерывания от АЦП для обработки результатов 

могут быть сконфигурированы либо после каждого преобразования, 

либо по окончании преобразования последовательности.  

 

 
 

Рис. 5.2. Блок-схема модуля АЦП в двухканальном режиме 
 

В двухканальном режиме автоматический секвенсер разделяется 

на две независимые части (“SEQ1” и “SEQ2”) со своими настройками 

и сигналами запуска. Входные каналы задается в регистрах CHSEL00 

.. CHSEL07 для последовательности SEQ1 и CHSEL08 .. CHSEL15 
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для последовательности SEQ2, результаты преобразования сохраня-

ется в регистрах RESULT0 .. RESULT7 и  RESULT8 .. RESULT15 со-

ответственно. Для любой из двух последовательностей может быть 
задан любой из 16 входных каналов. Данный режим позволяет полу-

чить фактически два независимых АЦП, со своими регистрами 

управления и сигналами запуска. Арбитр последовательности исполь-

зуется в случае одновременного появления сигналов запуска от двух 

последовательностей. В таком случае приоритет имеет SEQ1, преоб-

разование SEQ2 будет задержано до окончания SEQ1.  

 

 

Время преобразования и система тактирования АЦП.  

 

Рассмотрим настройку тактирования АЦП на примере. Тактиро-

вание АЦП осуществляется от высокоскоростного прескалера пери-

ферии HSPCLK (см. рис. 5.3).  

 

 
 

Рис. 5.3. Пример конфигурации модуля тактирования АЦП 

 

Максимальная частота на выходе  HSPCLK составляет 150 МГц. 

Максимальная частота тактирования АЦП FCLK согласно докумен-

тации составляет 25 МГц. ADCCLKPS служит для формирования 

требуемой частоты FCLK из HSPCLK. Бит CPS позволяет при необ-

ходимости понизить частоту в два раза. Полученная ADCCLK пода-
ется на ядро АЦП и на устройство выборки-хранения. Битами 

ACQ_PC можно задать необходимое время захвата сигнала. За это 
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время сигнал на УВХ должен установиться с заданной точностью. 

Время захвата зависит от сопротивления источника сигнала, характе-
ристик сигнала, требуемой точности и рассчитывается для каждого 

случая отдельно. В лабораторных работах сигнал подается с потен-

циометра, высокая точность не требуется, поэтому время выборки 

может быть задано любое.   
Минимальное время преобразования для первого канала в после-

довательности составляет 200 мкс, для последующих - 80 мкс.  
 

3. Формат регистров модуля АЦП 
 

 

 

 

Рис. 5.4. Регистр 1 управления АЦП  (ADCTRL1) 
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Рис. 5.5 Регистр 2 управления АЦП  (ADCTRL2) 
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Рис. 5.6. Регистр 3 управления АЦП  (ADCTRL3) 

 

Делитель частоты ядра. Периферийная частота процессора, HSPCLK, делится на 2* 

ADCCLKPS[3:0], за исключением, когда ADCCLKPS[3:0] = 0000, в этом случае 
HSPCLK не делится. Полученная частота дополнительно делится на ADCTRL1[7]+1.  

ADCCLKPS 

[3:0]  

Делитель 

частоты 

ядра  

ADCLK  

(частота тактирования АЦП) 

0000  0  HSPCLK/(ADCTRL1[7] + 1)  

0001  1  HSPCLK/[2*(ADCTRL1[7] + 1)]  

0010  2  HSPCLK/[4*(ADCTRL1[7] + 1)]  

0011  3  HSPCLK/[6*(ADCTRL1[7] + 1)]  

0100  4  HSPCLK/[8*(ADCTRL1[7] + 1)]  

0101  5  HSPCLK/[10*(ADCTRL1[7] + 1)]  

0110  6  HSPCLK/[12*(ADCTRL1[7] + 1)]  

0111  7  HSPCLK/[14*(ADCTRL1[7] + 1)]  

1000  8  HSPCLK/[16*(ADCTRL1[7] + 1)]  

1001  9  HSPCLK/[18*(ADCTRL1[7] + 1)]  

1010  10  HSPCLK/[20*(ADCTRL1[7] + 1)]  

1011  11  HSPCLK/[22*(ADCTRL1[7] + 1)]  

1100  12  HSPCLK/[24*(ADCTRL1[7] + 1)]  

1101  13  HSPCLK/[26*(ADCTRL1[7] + 1)]  

1110  14  HSPCLK/[28*(ADCTRL1[7] + 1)]  

1111  15  HSPCLK/[30*(ADCTRL1[7] + 1)]   
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Регистр числа каналов для преобразования  (ADCMAXCONV) 

 
 

Рис. 5.7. Формат регистра ADCMAXCONV 
 

 

 

 

 

Рис. 5.8. Регистр статуса автопоследовательности  (ADCASEQASR) 
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Каждый набор из 4-х бит CONVnn, выбирает  один из 16 аналоговых 

входов АЦП для последовательного автоматического преобразования.  

Значение CONVnn Выбираемый канал АЦП 

0000 ADCINA0 

0001 ADCINA1 

0010 ADCINA2 

0011 ADCINA3 

0100 ADCINA4 

0101 ADCINA5 

0110 ADCINA6 

0111 ADCINA7 

1000 ADCINB0 

1001 ADCINB1 

1010 ADCINB2 

1011 ADCINB3 

1100 ADCINB4 

1101 ADCINB5 

1110 ADCINB6 

1111 ADCINB7 

 

 
Буферный регистр результата АЦП  (ADCRESULTn) 

 

 
 

Рис. 5.9. Формат регистра ADCRESULTn 

 

В каскадном режиме начиная с регистра ADCRESULT8 по регистр 

ADCRESULT15 содержат результаты преобразования с девятого по 

шестнадцатый. Значения всех регистров ADCRESULTn выровнены 

по левому краю.  
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Порядок выполнения лабораторной работы № 5 

 

Часть I 

 

1. Создание проекта. 

1.1 В Code Composer Studio создаем новый проект Lab6.pjt. Ко-

пируем из папки c:\tidcs файл lab6.c в папку с созданным проектом. 

Добавляем lab6.c в проект. 
1.2 Добавляем в проект следующие файлы: 

C:\tidcs\c28\dsp281x\v100\DSP281x_headers\source\DSP281x_GlobalVar

iableDefs.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\cmd\F2812_EzDSP_RAM_l

nk.cmd 

C:\tidcs\c28\dsp281x\v100\DSP281x_headers\cmd\F2812_Headers_nonBI

OS.cmd 

C:\ti\c2000\cgtools\lib\rts2800_ml.lib 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\source\DSP281x_PieCtrl.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\source\DSP281x_PieVect.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\source\DSP281x_DefaultIs

r.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\source\DSP281x_Adc.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\source\DSP281x_usDelay.a

sm 

1.3 Включаем в проект заголовочные файлы: Project →  Build 

Options, в закладке Compiler выбираем Preprocessor и в поле Include 

Search Path (-i) вводим: 

C:\tidcs\C28\dsp281x\v100\DSP281x_headers\include;..\include. 

 1.4 Задаем глубину стека: Project → Build Options → Linker → 

Stack Size: 0x400. 

  

 2. Инициализация системы (подпрограмма “InitSystem()”). 

 2.1 Разрешаем работу сторожевого таймера (см. лаб.раб. №2), 

устанавливаем коэффициентом деления 64 (регистр WDCR), сбрасы-

ваем сторожевой таймер (регистр SCSR). 

 2.2 Настраиваем ЦСП на частоту 150 МГц (регистр PLLCR), в 

предделитель высокоскоростного таймера заносим 2. 

 2.3 Разрешаем тактирование модуля АЦП и Менеджера Собы-

тий (регистр PCLKCR). 
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//########################################################### 
// Имя файла: _lab6_.c 
// 
// Описание: Преобразование напряжений каналов ADCINA0  
//   и ADCINB0. Диапазон напряжений потенциометров,  
//  соединенных с каналами АЦП, от 0 до 3 В. Запуск АЦП  
//  от Менеджера Событий А. Результаты читаются по пре- 
//  рыванию и отображаются на светодиодах (GPIO B7-B0)  
//########################################################### 
 
#include "DSP281x_Device.h" 
 
void Gpio_select(void); 
void InitSystem(void);      
void show_ADC(int result);  
interrupt void adc_isr(void); // Подпрограмма обработки прерывания 
АЦП 
  
int Voltage_A0;     // Глобальные переменные 
int Voltage_B0;     
 
void main(void) 
{ 
 unsigned long i; 
 InitSystem();  // Инициализация регистров ЦСП 
 Gpio_select();  // Инициализация линий ввода/вывода 
 InitPieCtrl();  // Инициализации блока PIE  
 InitPieVectTable(); // Инициализация таблицы векторов блока 
PIE  
 InitAdc();   // Инициализация модуля АЦП 
     
 EALLOW; 
    PieVectTable.ADCINT = &adc_isr; 
    EDIS;     
 
 // Разрешение прерывания от АЦП: группа 1, прерывание 6 
 PieCtrlRegs.PIEIER1.bit.INTx6 = 1;                      
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 IER = 2;   // Разрешение прерываний линии 2 (INT2) 
    EINT;      // Разрешение общих прерываний INTM 
    ERTM;      // Разрешение общих прерываний в режи-
ме 
      // реального времени  
 
    // Настройка модуля АЦП 
 
 EALLOW; 
    SysCtrlRegs.PCLKCR.bit.ADCENCLK=1;   // Разрешение такти-
рования АЦП 
    EDIS;     
 
 AdcRegs.ADCTRL1.bit.SEQ_CASC = 0;    // Двухпоследова-
тельный режим 
    AdcRegs.ADCTRL1.bit.CONT_RUN = 0;    // Режим 
СТАРТ/СТОП 
    AdcRegs.ADCTRL1.bit.CPS = 0;     // Пределитель = 1  
 
    AdcRegs.ADCMAXCONV.all = 0x0001;       // Количество преоб-
разований 2 
 
 // Первое преобразование - канал ADCINA0 
    AdcRegs.ADCCHSELSEQ1.bit.CONV00 = 0x0;  
 
 // Второе преобразование - канал ADCINВ0 
    AdcRegs.ADCCHSELSEQ1.bit.CONV01 = 0x8;  
 
 // Разрешение начала преобразования от EVA 
    AdcRegs.ADCTRL2.bit.EVA_SOC_SEQ1 = 1;   
 
 // Разрешение запроса прерывания от SEQ1 
 AdcRegs.ADCTRL2.bit.INT_ENA_SEQ1 = 1;  
  
 // Коэффициент деления частоты = 4 
    AdcRegs.ADCTRL3.bit.ADCCLKPS = 2;  
 
 // Настройка модуля Менеджера Событий A 
 
 EALLOW; 
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   SysCtrlRegs.PCLKCR.bit.EVAENCLK=1; // Разрешение такти-
рования EVA 
 EDIS;     
 
    EvaRegs.GPTCONA.bit.TCMPOE = 1;  // Управление логикой 
сравнения  
          // T1PWM / 
T2PWM 
    // Полярность выходов сравнения GP таймера 1: активный уро-
вень - низкий  
 EvaRegs.GPTCONA.bit.T1PIN = 1; 
 
 // Разрешение выработки строба начала преобразования в EVA 
 EvaRegs.GPTCONA.bit.T1TOADC = 2;        
 
 EvaRegs.T1CON.bit.FREE = 0;  // Биты управления эму-
лятором: 
   EvaRegs.T1CON.bit.SOFT = 0;  // мгновенная остановка 
    EvaRegs.T1CON.bit.TMODE = 2; // Непрерывный счет вверх  
    EvaRegs.T1CON.bit.TPS = 7;  // Предделитель = 128 
    EvaRegs.T1CON.bit.TENABLE = 1; // Разрешение работы GP тай-
мера 1 
    EvaRegs.T1CON.bit.TCLKS10 = 0; // Внутренний источник 
тактирования 
    EvaRegs.T1CON.bit.TCLD10 = 0; // Перезагрузка GP таймера   
         // при достижении 
нуля 
    EvaRegs.T1CON.bit.TECMPR = 0; // Запрещение режима 
сравнения 
             
    EvaRegs.T1PR = 58594;       // Регистр периода GP таймера 
1 
 
    while(1) 
 {     
       for(i=0;i<1500000;i++) 
       { 
        EALLOW; 
         SysCtrlRegs.WDKEY = 0xAA;    
      EDIS; 
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       show_ADC(Voltage_A0>>8); // Отражение результата 
на светодиодах 
      } 
     for(i=0;i<1500000;i++) 
       { 
        EALLOW; 
   SysCtrlRegs.WDKEY = 0xAA;    
      EDIS; 
       show_ADC(Voltage_B0>>8);  // Отражение результата на 
светодиодах 
     } 
     } 
}    
    
//########################################################### 
// Подпрограмма: show_ADC 
// 
// Описание: Отображение диапазона входного напряжения 
//  на светодиодах 
//########################################################### 
         
void show_ADC(int result) 
{ 
 switch(result)  
   { 
  case 0 : GpioDataRegs.GPBDAT.all=0x0000;break; 
  case 1 : GpioDataRegs.GPBDAT.all=0x0001;break; 
  } 
 result>>=1; 
 switch(result)  
    { 
  case 1 : GpioDataRegs.GPBDAT.all=0x0003;break; 
  case 2 : GpioDataRegs.GPBDAT.all=0x0007;break; 
  case 3 : GpioDataRegs.GPBDAT.all=0x000F;break; 
  case 4 : GpioDataRegs.GPBDAT.all=0x001F;break; 
  case 5 : GpioDataRegs.GPBDAT.all=0x003F;break; 
  case 6 : GpioDataRegs.GPBDAT.all=0x007F;break; 
  case 7 : GpioDataRegs.GPBDAT.all=0x00FF;break; 
 } 
}      
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//########################################################### 
// Подпрограмма: adc_isr 
// 
// Описание: Обработка прерывания модуля АЦП 
//########################################################### 
 
interrupt void adc_isr(void)   
{ 
    EALLOW; 
 SysCtrlRegs.WDKEY = 0x55;   
 EDIS;   
     
    Voltage_A0 = AdcRegs.ADCRESULT0>>4; 
    Voltage_B0 = AdcRegs.ADCRESULT1>>4; 
 
   // Подготовка АЦП к следующему преобразованию 
   AdcRegs.ADCTRL2.bit.RST_SEQ1 = 1;  // Сброс SEQ1 
   AdcRegs.ADCST.bit.INT_SEQ1_CLR = 1;  // Сброс бита 
INT SEQ1 
   PieCtrlRegs.PIEACK.all = PIEACK_GROUP1; // 
Подтверждение  
           // преры-
вания в блоке PIE 
}           
 
//########################################################### 
// Подпрограмма: Gpio_select 
// 
// Описание: Настройка линий порта GPIO B15-8 на ввод, а линий 
//  B7-0 на вывод. Настройка всех линий портов A, D, F, E, G  
//  на ввод. Запрещение работы входного ограничителя 
//########################################################### 
 
void Gpio_select(void) 
{ 
 EALLOW; 
 GpioMuxRegs.GPAMUX.all = 0x0; // Настройка линий вво-
да/вывода на                            
    GpioMuxRegs.GPBMUX.all = 0x0; // работу в качестве портов    
    GpioMuxRegs.GPDMUX.all = 0x0; 
    GpioMuxRegs.GPFMUX.all = 0x0;    
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    GpioMuxRegs.GPEMUX.all = 0x0;  
    GpioMuxRegs.GPGMUX.all = 0x0;    
           
    GpioMuxRegs.GPADIR.all = 0x0;  // Настройка портов А, D, 
E, F, G на ввод 
 GpioMuxRegs.GPBDIR.all = 0x00FF; // Настройка линий 15-8 
на ввод, а линий  
    GpioMuxRegs.GPDDIR.all = 0x0;  // 7-0 на вывод 
    GpioMuxRegs.GPEDIR.all = 0x0;  
    GpioMuxRegs.GPFDIR.all = 0x0;  
    GpioMuxRegs.GPGDIR.all = 0x0;  
 
    GpioMuxRegs.GPAQUAL.all = 0x0; //Запрещение входного ограни-
чителя 
    GpioMuxRegs.GPBQUAL.all = 0x0; 
    GpioMuxRegs.GPDQUAL.all = 0x0; 
    GpioMuxRegs.GPEQUAL.all = 0x0; 
    EDIS; 
}      
 
//########################################################### 
// Подпрограмма: InitSystem 
// 
// Описание: Настройка сторожевого таймера на работу, 
//  предделитель = 1. Выработка сброса сторожевым  
//  таймером. Внутренняя частота работы ЦСП 150 МГц. 
//  Запись в предделитель высокоскоростного таймера  
//  коэффициента деления 2, а в предделитель 
//  низкоскоростного таймера - 4. Запрещение работы  
//  периферийных устройств 
//########################################################### 
 
void InitSystem(void) 
{ 
    EALLOW; 
    SysCtrlRegs.WDCR= 0x00AF; // Разрешение работы сто   
     // рожевого таймера, предделитель = 64 
     // 0x00E8 - запрещение работы  сторо- 
     // жевого таймера, предделитель = 1 
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    SysCtrlRegs.SCSR = 0;    // Выработка сброса WDT
  
    SysCtrlRegs.PLLCR.bit.DIV = 10; // Настройка блока  

  // умножения частоты 
    SysCtrlRegs.HISPCP.all = 0x1;  // Задание значения преддели-
теля высо- 
    SysCtrlRegs.LOSPCP.all = 0x2;  // коскоростного и низкоскоро-
стного  
         // таймеров       
 
    SysCtrlRegs.PCLKCR.bit.EVAENCLK=0; // Запрещение рабо-
ты периферий- 
    SysCtrlRegs.PCLKCR.bit.EVBENCLK=0; // ных устройств 
    SysCtrlRegs.PCLKCR.bit.SCIAENCLK=0; 
    SysCtrlRegs.PCLKCR.bit.SCIBENCLK=0; 
    SysCtrlRegs.PCLKCR.bit.MCBSPENCLK=0; 
    SysCtrlRegs.PCLKCR.bit.SPIENCLK=0; 
    SysCtrlRegs.PCLKCR.bit.ECANENCLK=0; 
    SysCtrlRegs.PCLKCR.bit.ADCENCLK=0; 
    EDIS; 
} 
 

Рис. 5.10. Текст программы 
 

3. Инициализация портов (подпрограмма “Gpio_select()”). 

3.1 Настраиваем все выводы на работу в качестве портов (ре-
гистр GPxMUX) (см. лаб.раб. №2). 
 3.2. Настраиваем порты A, D, E, F, G на ввод (регистр GPxDIR). 
 3.3 Настраиваем линии порта GPIOB15 – GPIOB8 на ввод, а 
GPIOB7 – GPIOB0 на вывод. 
 3.4 Сбрасываем биты регистров GPxQUAL в ноль. 
 
 4. Инициализация модуля Менеджера Событий. 

 4.1 Запрещаем выходы сравнения и выбираем полярность выхо-
дов сравнения принудительный низкий уровень (регистр GPTCONA) 
(см. лаб.раб. №3). 
 4.2 В регистре T1CON выбираем: непрерывный режим счета 
вверх, синхронизация от внутреннего источника, запрещаем режим 
сравнения, разрешаем работу GP таймера 1, задаем коэффициент де-
ления 128. 
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 4.3 Разрешаем запуск АЦП от Менеджера Событий А (регистр 
GPTCONA). 

4.4 Рассчитываем значение периода (T1PR), зная, что PWMf  = 10 

Гц:  

HISCPTPSPR1T

f
f

1T

CPU
PWM 

  

 
5. Инициализация модуля АЦП. 

5.1 Задаем: двух последовательный режим, запрещаем непре-
рывный режим, коэффициент деления 1 (регистр ADCTRL1). 

5.2 Записываем количество преобразований 2 (регистр AD-
CMAXCONV). 

5.3 Выбираем каналы ADCIN_A0 и ADCIN_B0 (регистр 
ADCCHSELSEQ1). 

5.4 Разрешаем преобразования от Менеджера Событий А, раз-
решаем прерывания АЦП в конце каждой последовательности (ре-
гистр ADCTRL2) 

5.3 Задаем делитель частоты высокоскоростного таймера рав-
ный 4. 
 

6. Настройка прерываний. 

6.1 Указываем адрес вектора прерываний (регистр ADCINT). 
6.2 Разрешаем прерывание 6 группы 1 (регистр PIEIER1). 
6.3 Вызываем подпрограммы инициализации: модуля прерыва-

ния периферийных устройств “InitPieCtrl()”,  вектора прерывания пе-
риферийных устройств “InitPieVectTable()”, модуля АЦП “InitAdc()”. 

 
7. Получение результатов преобразования АЦП (подпро-

грамма “adc_isr()”). 

7.1 Считываем результаты преобразования из регистров AD-
CRESULT0 и ADCRESULT1 и сохраняем их соответственно в пере-
менные Voltage_A0 и Voltage_B0. Так как данные в регистрах AD-
CRESULTn выровнены к левому краю, необходимо произвести сдвиг 
данных на четыре разряда вправо. 

7.2 Подготавливаем АЦП к следующему преобразованию: сбра-
сываем последовательность SEQ1 (регистр ADCTRL2), сбрасываем 
бит прерывания SEQ1 (регистр ADCST), подтверждаем прерывания 
(регистр PIEACK). 
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8. Вывод показаний АЦП на светодиодные индикаторы 

8.1. В основной подпрограмме main() написать программу выво-

да показаний данных из АЦП на линейку светодиодных индикаторов. 

Для этого необходимо использовать подпрограмму show_ADC(result), 

которая отображает четыре младших бита параметра result на свето-

диодных индикаторах в виде светящейся линейки. Вывод показаний с 
каждого канала осуществлять поочередно через 1 секунду. В про-

грамме также необходимо сбрасывать сторожевой таймер процессора.  
8.2. Компонуем проект: Project → Build.  

8.3 Загружаем выходной файл: File → Load Program → Debug\ 

lab6.out. 

8.4. Запускаем программу на выполнение Debug → Run. 

8.5. Контролируем правильное выполнение программы, изменяя 

потенциометрами напряжение, подаваемое на входы АЦП и наблюдая 

за линейкой светодиодных индикаторов. 

 

 

9. Задание для самостоятельной работы 

Написать программу «бегущий огонь», аналогичную разрабо-

танной в лабораторной работе № 2. Скорость движения «бегущего 

огня» задавать потенциометром канала ADCIN_A0.  

 

Содержание отчета: 

 

Отчет должен содержать цель работы, краткие теоретические сведе-
ния по теме работы, рисунки, поясняющий структуру и режимы рабо-

ты АЦП, тексты исследуемых программ,  результаты их выполнения, 

выводы. 

 

Контрольные вопросы: 

 

1.  Встроенный АЦП DSP TMS320F2812: структура, параметры, 

режимы работы. 

2.  Каскадный режим работы АЦП: особенности, источники за-
пуска преобразования. 

3.  Двухканальный режим работы АЦП: особенности, источники 

запуска преобразования. 

4. Система тактирования АЦП.  

5. Регистры АЦП. 
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Лабораторная работа № 6 
Исследование встроенного CAN-интерфейса DSP TMS320F2812 

 
Цель работы: изучить характеристики встроенного CAN-

интерфейса DSP TMS320F2812. 
 

Теоретические сведения 
 

1. Особенности CAN-интерфейса DSP TMS320F2812 

 

Модуль eCAN имеет следующие особенности: 

1) Протокол версии 2.0В, полностью совместимый с CAN; 

2) Поддержка скоростей передачи данных до 1 Мбит/с; 
3) 32 почтовых ящика, каждый со следующими свойствами: 

- конфигурация на прием или передачу; 

- стандартный или расширенный идентификатор; 

- фильтр с программируемой маской при приеме; 
- поддержка кадров удаленного запроса данных; 

- поддержка 0-8 байтов данных; 

- возможность установки 32-разрядной временной метки на 
принятом и переданном сообщениях; 

- защита от приема нового сообщения; 

- программирование приоритета передающего сообщения. 

- использование программируемой системы прерываний с двумя 

уровнями прерываний; 

- программируемое прерывание по окончании времени передачи 

или приема.  
4) Режим пониженного энергопотребления; 

5) Программируемый выход из режима пониженного энергопо-

требления при  появлении активности на шине; 
6) Автоматический ответ на удаленный запрос данных; 

7) Автоматический повтор передачи при потере арбитража или в 

случае возникновения ошибки; 

8) 32-разрядный счетчик временной метки, синхронизирован-

ный на определенное сообщение; 
9) Режим самопроверки: 

- работа в режиме петли; прием своего собственного сообщения, 

что устраняет потребность в другом узле для определения бита при-

знака. 
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Рис. 6.1. Блок-схема CAN-интерфейса в ЦСП TMS320F2812 

 

 

2. Совместимость eCAN с другими CAN-модулями 

 

eCAN-модуль идентичен ”Высокопроизводительному CAN-

контроллеру (НЕСС)”, используемому в микроконтроллерах серии 

TMS470 фирмы Texas Instruments, с некоторыми незначительными 

изменениями. Также модуль eCAN представлен более широко (уве-
личенное число Mailbox с индивидуальными приемными масками, 

временные метки и т.д.) в сравнении с CAN-модулем ЦСП семейства 
240х. Поэтому программы, написанные для CAN-модуля 240х, не мо-

гут применяться к eCAN 320х. Однако eCAN обладает той же самой 

структурой размещения разрядов регистров и функциональными воз-
можностями, как и CAN серии 240х (для регистров, существующих в 
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обоих устройствах), т.е. большинство регистров и битов выполняют 
идентичные функции на двух платформах. Это упрощает перемеще-
ние программ, написанных на языке С++. 

 

2.1. Модуль и сеть CAN 

 

В локальной контроллерной сети (CAN) используется последо-

вательный протокол ведущей передачи, который эффективно под-

держивает распределенное управление в реальном времени с сверх-

высоким уровнем безопасности и скоростью передачи до 1 Мбит/с. 
CAN-шина идеальна для приложений, работающих в зашумленных 

средах, в автомобильных и других индустриальных областях, которые 
требуют надежной коммуникации. 

Расположенные по приоритетам сообщения, до 8 байтов данных 

в длину, посылаются на ведущую шину, использующую арбитражный 

протокол и механизм обнаружения ошибок для высокого уровня це-
лостности данных. 

 

2.2. Протоколы CAN 

 

CAN поддерживает четыре типа различных типов кадров для 

передачи: 

- кадры, передающие данные от передающего узла к прини-

мающему; 

- удаленные кадры, переданные узлом с целью запроса кадра 
данных с таким же идентификатором; 

- кадры паузы, обеспечивающие дополнительную задержку ме-
жду предшествующим и последующим кадром данных или удален-

ными кадрами; 

- кадры об ошибках, передающиеся любым узлом на шине, об-

наружившим ошибку. 

Кроме того, в версии CAN 2.0В определены два вида формата 
сообщений, которые отличаются длиной полей идентификатора: 
стандартный кадр с 11-разрядным идентификатором и расширенный 

кадр с 29-разрядным идентификатором. 

Сообщения CAN со стандартными кадрами данных содержат от 
44 до 108 битов, а сообщения CAN с расширенными кадрами данных 

содержат от 64 до 128 битов. Кроме того, могут быть добавлены до 23 

битов данных в стандартном кадре и до 28 данных в расширенном 
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кадре данных, в зависимости от кодировки потока данных. Полная 

максимальная длина сообщения – 131 бит со стандартным кадром и 

156 бит с расширенным кадром. 

Поля битов, находящиеся в стандартных/расширенных кадрах 

данных, расположенные как показано на рисунке 6.2, включают в се-
бя следующее: 

- бит начала кадра SOF; 

- поле арбитража, содержащее идентификатор и тип посылаемо-

го сообщения (11-разрядный идентификатор + бит RTR стандартного 

формата кадра или 29-разрядный идентификатор + бит SRR + бит IDE 

+ бит RTR расширенного формата кадра); 
- управляющее поле, содержащее размер данных (6 бит); 
- данные (до 8 байтов); 

- поле циклического контроля избыточности (CRC) – 16 бит; 
- 2 бита подтверждения; 

- 7 битов конца кадра. 
 

 
 

Рис. 6.2. Структура кадра сообщения стандартного формата 
 

В TMS320x28xx CAN-контроллеры предоставляют центрально-

му процессору полные функциональные возможности, с помощью 

CAN-протоколов версии 2.0В. CAN-контроллер минимизирует за-
грузку CPU при передаче и увеличивает возможности CAN. 

Архитектура CAN-модуля, показанная на рисунке 6.3, состоит 
из ядра протоколов (CPK) и контроллера сообщений. 

CPK выполняет 2 функции. Первая – декодирование всех сооб-

щений, появляющихся на шине согласно протоколам CAN, и переда-
ча этих сообщений в буфер приема. Вторая функция – передача со-

общений на шину, согласно протоколу CAN. 

Контроллер сообщений решает, должно ли принятое в CPK со-

общение быть сохранено для использования CPU, или нет. При ини-

циализации CPU передает контроллеру сообщений идентификаторы 
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всех сообщений, которые будут использоваться. Контроллер сообще-
ний также отвечает за передачу следующего сообщения из CPK со-

гласно приоритету сообщений. 

 

 
Рис. 6.3. Архитектура модуля eCAN 

 

 

2.3. Контроллеры еCAN 

 

eCAN-модуль состоит из: 
1) ядра протоколов CAN; 

2) контроллера сообщений, содержащего: 

- модуль управления памятью, включая интерфейс CPU, блок 

управления приемом (фильтрация) и модуль управления таймером; 

- ОЗУ Mailbox, позволяющая хранить до 32 сообщений; 

- регистры управления и состояния. 

После приема сообщения CPK определяет блок управления 

приемом в контроллере сообщений, который решает, сохранять при-

нятое сообщение в одну из 32 ячеек ОЗУ Mailbox или нет. Блок 

управления анализирует идентификатор и сравнивает с масками Mail-

box для определения номера Mailbox, в котором будет сохранено со-
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общение. При совпадении маски и идентификатора принятое сообще-
ние сохраняется в соответствующий Mailbox. Если блок управления 

приемом не обнаружил совпадения маски и идентификатора, то со-

общение игнорируется. 
Сообщение состоит из 11- или 29-разрядного идентификатора, 

поля управления и поля данных до 8 байт. 
При необходимости передачи сообщения контроллер сообще-

ний передает сообщение в буфер передачи CPK, который осуществит 
передачу в следующем неактивном состоянии шины. Когда необхо-
димо передать несколько сообщений, контроллер сообщений сначала 
передает в буфер передачи CPK сообщение с самым высоким приори-
тетом, а после его отправки – следующее по убыванию приоритета 
сообщение. Если два Mailbox имеют одинаковые приоритеты, то сна-
чала передается сообщение из Mailbox с более высоким номером. 

Модуль управления таймером включает в себя счетчик времен-
ной метки и привязывает эту метку ко всем полученным и передан-
ным сообщениям. Прерывание происходит, когда сообщение не при-
нято или передано в течение некоторого ограниченного времени. 
Особенность ограничения времени на прием/передачу доступна толь-
ко в модуле CAN. 

Для инициализации переданных данных бит запроса передачи 
должен быть установлен в соответствующем регистре управления. 
Тогда процедура передачи и обработки сообщений выполняется без 
привлечения CPU. Если Mailbox ориентирован на прием, то CPU лег-
ко читает его регистры, используя команды разрешения чтения. Mail-
box формирует прерывание CPU после каждого успешного прие-
ма/передачи сообщения. 

 
2.3.1. Режим стандартного контроллера CAN (SCC) 

 
Режим SCC – это упрощенный режим функциональных возмож-

ностей еCAN. В этом режиме доступны только 16 Mailbox (от 0 до 
15). Особенность ограничения времени недоступна и число доступа к 
маскам для приема сообщений сокращено. Этот режим устанавлива-
ется по умолчанию. Переход из режима SCC в режим полного еCAN 
осуществляется с помощью бита SCB (CANMC.13). 

 
2.3.2. Карта памяти 

 
еCAN-модуль имеет два банка адресов, отражаемых в памяти 

TMS320x28xx. Первый банк используется для обращения к регистрам 
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управления, регистрам состояния, приемным маскам, временной мет-
ке и ограничению времени исследования сообщения. Доступ к реги-
страм управления и состояния ограничен 32-разрядной шиной. К при-
емным маскам, регистрам временной метки и регистрам ограничения 
времени можно обратиться 8-, 16- и 32-разрядными шинами. Каждый 
из этих двух банков памяти, которые показаны на рисунке 6.4, ис-
пользует 512 байтов адресного пространства. Аналогично выглядит 
карта памяти eCAN-В, изображенная на рисунке 6.5. 
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Рис. 6.4. Карта памяти eCAN-A 
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Рис. 6.5. Карта памяти eCAN-В 
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Хранение сообщения осуществляется оперативной памятью, к 

которой может обратиться CAN-контроллер или CPU. CPU при по-

мощи CAN-контроллера может превратить различные Mailbox в ОЗУ 

или в дополнительную память. Дополнительная память может ис-
пользоваться для хранения различных элементов, необходимых для 

фильтрации принятых сообщений и обработки прерываний. 

Модуль Mailbox еCAN представляет собой 32 почтовых ящика, 
в каждом из которых содержится до 8 байт данных, до 29 битов иден-

тификатора и несколько служебных битов сообщения. Каждый Mail-

box может быть ориентирован как на прием, так и на передачу сооб-

щения. В еCAN каждый Mailbox имеет свою индивидуальную маску. 

 

2.3.3. Регистры управления и состояния eCAN 

 

Регистры eCAN, перечисленные в таблице 6.1, используются 

CPU для конфигурации и управления контроллером CAN при работе 
с сообщениями. 

Таблица 6.1. Регистры eCAN 

 

Название 
регистра 

Адреса 
eCAN-A 

Адреса 
eCAN-B 

Разрядность 

(х32) 

Описание 

CANME 0x6000 0x6200 1 Регистр разрешения 

Mailbox 

CANMD 0x6002 0x6202 1 Регистр направления 

CANTRS 0x6004 0x6204 1 Регистр установки за-
проса передачи 

CANTRR 0x6006 0x6206 1 Регистр сброса запроса 
передачи 

CANTA 0x6008 0x6208 1 Регистр подтверждения 

приема 
CANAA 0x600A 0x620A 1 Регистр подтверждения 

передачи 

CANRMP 0x600C 0x620C 1 Регистр ожидания при-

нимаемого сообщения 

CANRML 0x600E 0x620E 1 Регистр потери принято-

го сообщения 

CANRFP 0x6010 0x6210 1 Регистр ожидания кадра 
удаленного запроса дан-

ных 
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Название 
регистра 

Адреса 
eCAN-A 

Адреса 
eCAN-B 

Разрядность 

(х32) 

Описание 

CANGAM 0x6012 0x6212 1 Регистр маска глобаль-

ного приема 
CANMC 0x6014 0x6214 1 Регистр главного управ-

ления  

CANBTS 0x6016 0x6216 1 Регистр конфигурации 

синхронизации 

CANES 0x6018 0x6218 1 Регистр ошибок и со-

стояния 

CANTEC 0x601A 0x621A 1 Регистр счетчика оши-

бок передачи 

CANREC 0x601C 0x621C 1 Регистр счетчика оши-

бок приема 
CANGIF0 0x601E 0x621E 1 Регистр флага 0 гло-

бальных прерываний 

CANGIM 0x6020 0x6220 1 Регистр глобальной мас-
ки прерываний 

CANGIF1 0x6022 0x6222 1 Регистр флага 1 гло-

бальных прерываний 

CANMIM 0x6024 0x6224 1 Регистр маски прерыва-
ний Mailbox 

CANMIL 0x6026 0x6226 1 Регистр уровня преры-

ваний Mailbox 

CANOPC 0x6028 0x6228 1 Регистр управления за-
щитой перезаписи 

CANRIOS 0x602A 0x622A 1 Регистр управления вхо-

дами eCAN 

CANTIOS 0x602C 0x622C 1 Регистр управления вы-

ходами eCAN 

CANTSC 0x602E 0x622E 1 Счетчик временной мет-
ки (reserved в режиме 
SCC) 

CANTOC 0x6030 0x6230 1 Управление ограничени-

ем времени (reserved в 

режиме SCC) 

CANTOS 0x6032 0x6232 1 Состояние ограничения 

времени (reserved в ре-
жиме SCC) 
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2.4. Работа с сообщениями 

 

eCAN-модуль имеет 32 различных Mailbox, каждый из которых 

имеет свою индивидуальную приемную маску и может быть настроен 

на прием или передачу. 

Сообщение Mailbox содержит: 
- 29-разрядный идентификатор сообщения; 

- регистр управления сообщением; 

- до 8 байтов данных; 

- 29-разрядная приемная маска; 
- 32-разрядная временная метка; 
- 32-разрядное значение ограничения времени. 

Соответствующие биты регистров состояния и управления по-

зволяют управлять сообщениями. 

 

2.5. Mailbox 

 

Mailbox – это область оперативной памяти, где сообщения CAN 

сохраняются после того, как они приняты, или прежде, чем они будут 
отправлены. 

CPU может использовать области оперативной памяти Mailbox, 

не используемые для хранения сообщений, как обычную память. 

Каждый Mailbox содержит: 
1) Идентификатор сообщения: 

- 29-разрядов для расширенного идентификатора; 
- 11-разрядов для стандартного идентификатора; 
2) Бит расширения идентификатора, IDE (MSGID,31); 

3) Бит установки приемной маски, AME (MSGID,30); 

4) Бит автоматического ответа, AAM (MSGID,29); 

5) Уровень приоритетной передачи, TPL (MSGCTRL,12-8); 

6) Бит удаленного запроса данных, RTR (MSGCTRL,4); 

7) Код длины данных, DLC (MSGCTRL,3-0); 

8) Поле данных до 8 байтов. 

Каждый из Mailbox может работать в режиме одного из четырех 

типов сообщения (см. таблицу 6.2). Прием и передача сообщений не-
обходимы для обмена данными между передающим узлом и много-

численными узлами-приемниками, тогда как сообщения запроса и 

подтверждения используются для поддержания взаимосвязи на шине. 
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     Таблица 6.2. Конфигурация сообщений  

 

Виды сообще-
ний 

Регистр на-
правления 

Mailbox 

(CANMD) 

Бит установки 

режима автома-
тического отве-

та (AAM) 

Бит установки 

запроса данных 

(RTR) 

Передача сооб-

щения 

0 0 0 

Прием сообще-
ния 

1 0 0 

Сообщение-
запрос 

1 0 1 

Сообщение-
ответ 

0 1 0 

 

Таблица 6.3 показывает расположение байтов Mailbox eCAN-A 

в ОЗУ. 

 

   Таблица 6.3. Расположение байтов Mailbox eCAN-A в ОЗУ 

 

Mailbox MSGID  

MIDL-MIDH 

MSGCTRL  

MCF-Rsvd 

MDL  

MDL_L-

MDL_H 

MDH  

MDH_L-

MDH_H 

0 6100-6101h 6102-6103h 6104-6105h 6106-6107h 

1 6108-6109h 610A-610Bh 610C-610Dh 610E-610Fh 

2 6110-6111h 6112-6113h 6114-6115h 6116-6117h 

3 6118-6119h 611A-611Bh 611C-611Dh 611E-611Fh 

4 6120-6121h 6122-6123h 6124-6125h 6126-6127h 

5 6128-6129h 612A-612Bh 612C-612Dh 612E-612Fh 

6 6130-6131h 6132-6133h 6134-6135h 6136-6137h 

7 6138-6139h 613A-613Bh 613C-613Dh 613E-613Fh 

8 6140-6141h 6142-6143h 6144-6145h 6146-6147h 

9 6148-6149h 614A-614Bh 614C-614Dh 614E-614Fh 

10 6150-6151h 6152-6153h 6154-6155h 6156-6157h 

11 6158-6159h 615A-615Bh 615C-615Dh 615E-615Fh 

12 6160-6161h 6162-6163h 6164-6165h 6166-6167h 

13 6168-6169h 616A-616Bh 616C-616Dh 616E-616Fh 

14 6170-6171h 6172-6173h 6174-6175h 6176-6177h 

15 6178-6179h 617A-617Bh 617C-617Dh 617E-617Fh 



 107

Mailbox MSGID  

MIDL-MIDH 

MSGCTRL  

MCF-Rsvd 

MDL  

MDL_L-

MDL_H 

MDH  

MDH_L-

MDH_H 

16 6180-6181h 6182-6183h 6184-6185h 6186-6187h 

17 6188-6189h 618A-618Bh 618C-618Dh 618E-618Fh 

18 6190-6191h 6192-6193h 6194-6195h 6196-6197h 

19 6198-6199h 619A-619Bh 619C-619Dh 619E-619Fh 

20 61AO-61A1h 61A2-61A3h 61A4-61A5h 61A6-61A7h 

21 61A8-61A9h 61AA-61ABh 61AC-61ADh 61AE-61AF 

22 61BO-61B1h 61B2-61B3h 61B4-61B5h 61B6-61B7h 

23 61B8-61B9h 61BA-61BBh 61BC-61BDh 61BE-61BFh 

24 61CO-61C1h 61C2-61C3h 61C4-61C5h 61C6-61C7h 

25 61C8-61C9h 61CA-61CBh 61CC-61CDh 61CE-61CFh 

26 61DO-61D1h 61D2-61D3h 61D4-61D5h 61D6-61D7h 

27 61D8-61D9h 61DA-61DBh 61DC-61DDh 61DE-61DF 

28 61EO-61E1h 61E2-61E3h 61E4-61E5h 61E6-61E7h 

29 61E8-61E9h 61EA-61EBh 61EC-61EDh 61EE-61EFh 

30 61FO-61F1h 61F2-61F3h 61F4-61F5h 61F6-61F7h 

31 61F8-61F9h 61FA-61FBh 61FC-61FDh 61FE-61FFh 

 

2.5.1. Передача в Mailbox 

 

CPU хранит данные, которые передаются в настроенный на пе-
редачу сообщения Mailbox. После присоединения к данным иденти-

фикатора посылается запрос в ОЗУ, был ли бит TRS установлен, раз-
решается ли работа Mailbox, при этом устанавливается бит передачи 

ME.n (n – номер Mailbox). 

Если более одного Mailbox готовы к передаче и более чем один 

соответствующий бит TRS установлен, сообщения посылаются по 

очереди в порядке уменьшения, начиная с Mailbox с самым высоким 

приоритетом. 

В режиме SCC приоритет передающего Mailbox зависит от но-

мера Mailbox. Самый высокий номер Mailbox (=15) обладает самым 

высоким приоритетом передачи. 

В eCAN приоритет передачи Mailbox зависит от состояния реги-

стра управления сообщением (MSGCTRL) в поле TPL. Сначала пере-
дает Mailbox с самым высоким значением поля TPL. Только когда два 
Mailbox имеют одинаковые значения TPL-полей, сначала передает 
Mailbox с высшим номером. 
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Если во время передачи будет допущена ошибка из-за потери 

арбитража или другая ошибка, то передача сообщения будет произве-
дена вновь. Перед повтором передачи CAN-модуль проверяет, нет ли 

запросов от других узлов, и затем разрешает передачу Mailbox с са-
мым высоким приоритетом. 

 

2.5.2. Прием в Mailbox 

 

Идентификатор каждого принятого сообщения сравнивается с 
идентификатором, содержащимся на каждом Mailbox, используя мас-
ку. Когда обнаружено совпадение, полученный идентификатор, биты 

управления и байты данных записываются на  определенный ОЗУ ад-

рес. В то же время формируется бит ожидания приема сообщения 

RMP[n] (RMP.31-0), устанавливается и происходит прерывание, если 

оно разрешено. Если сообщение идентификатора не произошло, то 

сообщение не сохраняется [5]. 

При приеме сообщения контроллер сообщения начинает искать 

соответствующий идентификатор в Mailbox, начиная с самого высо-

кого номера. Mailbox 15 в SCC-режиме имеет самый высокий номер 

и, следовательно, высший приоритет. Mailbox 31 имеет самый высо-

кий номер при выключенном режиме SCC и имеет наивысший при-

оритет в eCAN-модуле. 
Регистр RMP[n] (RMP.31-0) должен быть сброшен CPU после 

чтения данных. Если принимается второе сообщение для одного 

Mailbox и бит ожидания приема сообщения уже установлен, то уста-
навливается бит RML[n] (RML.31-0) и сообщение задерживается. 

Хранимое сообщение записывается поверх с новыми данными, если 

сброшен бит защиты наложения записи OPC[n] (OPC.31-0), иначе 
проверяется следующий Mailbox. 

Если Mailbox настроен на прием и бит RTR установлен для это-

го, Mailbox может передать кадр удаленного запроса данных. Как 

только запрос передан, бит TRS Mailbox eCAN сбрасывается. 

 

2.5.3. Операции CAN-модуля в нормальном режиме 
 

Если CAN-модуль работает в нормальном режиме (не в режиме 
самопроверки), то должен быть как минимум еще один CAN-модуль в 

сети, настроенный на такую же скорость передачи информации в би-

тах. Второй CAN-модуль может быть настроен на прием сообщений 
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от передающего узла, но должен быть настроен на ту же самую ско-

рость передачи информации в битах. Это необходимо, т.к. передаю-

щий CAN-модуль видит, что есть как минимум один узел в CAN-сети, 

чтобы подтвердить правильную передачу переданного сообщения в 

сеть. Согласно CAN-протоколу любой узел, который получил сооб-

щение, присылает подтверждение (если программно не отключено), 

независимо от того, был ли он настроен на получение именно этого 

сообщения, или нет. 
Необходимость второго узла отсутствует в режиме самопроверки 

(STM). В этом режиме передающий узел формирует свой собствен-

ный сигнал. Единственное требование – узел должен быть настроен 

на любую рабочую скорость передачи информации. Т.о. регистры 

синхронизации не должны содержать значения, не актуальные для 

CAN-протокола.   
 

Порядок выполнения лабораторной работы  

 

1. Настройка отправки сообщения 

 

1) Создание нового проекта. 
1.1) В Code Composer Studio создать новый проект Lab9.pjt. От-

крыть файл Lab9.c и сохранить его в E:\C281x\Labs\Lab9\lab9.c.  

1.2) Добавить в проект файлы: 

C:\tidcs\c28\dsp281x\v100\DSP281x_headers\source\DSP281x_GlobalVar

iableDefs.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\source\DSP281x_PieCtrl.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\source\ 

DSP281x_PieVect.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\source\DSP281x_DefaultIs

r.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\source\DSP281x_CpuTime

rs.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_headers\cmd\F2812_Headers_nonBI

OS.cmd 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\cmd\F2812_EzDSP_RAM

_lnk.cmd 

C:\ti\c2000\cgtoolslib\ rts2800_ml.lib 

2) Настройка параметров проекта, компоновка проекта и загруз-
ка выходного файла. 
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2.1) Включить в проект заголовочные файлы: Project → Build 

Options, в закладке Compiler выбрать Preprocessor и в поле Include 

Search Path (-i) ввести:  

C:\tidcs\C28\dsp281x\v100\DSP281x_headers\include; ..\include 

 2.2) Задать глубину стека: Project → Build Options → Linker → 

Stack Size: 0x400. 

 2.3) Закрыть Build Options, кликнув OK. 

3) Преобразование файла Lab9.c. 

3.1) Настроить в основной программе цикл while( ) таким обра-
зом, чтобы каждая отправка осуществлялась через 1 секунду. Сделать 

прерывание «CPU core timer 0» через каждые 50 мс для увеличения 
значения  “CpuTimer0.InterruptCount”. 

3.2) Создать новую структуру в основной программе 
“ECanaShadow”: 

struct ECAN_REGS ECanaShadow; 

3.3) В подпрограмме «Gpio_select( )» настроить периферийные 
функции CANTxA и CANRxA для работы с CAN-модулем: 

GpioMuxRegs.GPFMUX.bit.CANTXA_GPIOF6 = 1; 

GpioMuxRegs.GPFMUX.bit.CANRXA_GPIOF7 = 1; 

3.4) В конце кода программы создать подпрограмму InitCan( ), с 
помощью которой осуществить следующие шаги: 

3.4.1) В регистрах “ECanaRegs.CANTIOC” и “ECa-

naRegs.CANRIOC” установить биты “TXFUNC” и “RXFUNC”. 

3.4.2) Включить режим HECC модуля CAN (регистр 

“ECanaRegs.CANMC”). 

3.4.3) Для получения доступа к регистрам времени установить 

бит “CCR” регистра “ECanaRegs.CANMC”. 

3.4.4) Для передачи запроса инициализации CAN установить 

флаг “CCE” регистра “ECanaRegs.CANES”. 

3.4.5) Установить параметры “BRP”, “TSEG1” и “TSEG2” реги-

стра “ECanaRegs.CANBTC” таким образом, чтобы скорость передачи 

была 100 кбит/с. 
3.4.6) После установки параметров  регистра 

“ECanaRegs.CANBTC” запретить к нему доступ - очистить бит CCR 

регистра “ECanaRegs.CANMC”.  

3.4.7) Отключить все mailboxes, кроме того, который отправляет 
сообщение, установкой в 0 полей регистра “ECanaRegs.CANME”. 

3.5) Для подготовки mailbox#5 к отправке сообщения сделать 
следующее: 
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3.5.1) Установить идентификатор сообщения 0x10000000 (бит 
“IDE” регистра “EcanaMboxes.MBOX5.MSGID”). Также установить 

бит IDE регистра “EcanaMboxes.MBOX1.MSGID” в 1. 

3.5.2) Для установления mailbox#5 передающим, сбросить бит 
“MD5” регистра “ECanaRegs.CANMD”. Так как мы не имеем доступа 
к регистру “ECanaRegs.CANMD”, то сделать это следующим образом: 

ECanaShadow.CANMD.all = ECanaRegs.CANMD.all; 

ECanaShadow.CANMD.bit.MD5 = 0; 

ECanaRegs.CANMD.all = ECanaShadow.CANMD.all; 

Активировать mailbox#5: 

ECanaShadow.CANME.all = ECanaRegs.CANME.all; 

ECanaShadow.CANME.bit.ME5 = 1; 

ECanaRegs.CANME.all = ECanaShadow.CANME.all; 

3.8.3) Установить длину сообщения равной 1 (бит DLC регистра 
“ECanaMboxes.MBOX5.MSGCTRL”). 

4) Присоединение байта данных и отправка. 
Теперь надо организовать периодическую загрузку байта дан-

ных в mailbox и отправку с помощью цикла while(1). Для этого: 

4.1) Из входных портов GPIO-Port B (с 15 по 8 бит) загрузить 
байт данных в регистр “ECanaMboxes.MBOX5.MDL.byte.BYTE0”. 

4.2) Послать запрос передачи mailbox#5. Для этого  в регистре 
“ECanaShadow.CANTRS” установить бит TRS5=1, а все остальные 0. 

Затем загрузить все это в регистр “ECanaRegs.CANTRS”. 

4.3) Как только придет запрос на отправку сообщения, флаг 
“ECanaRegs.CANTA.bit.TA5” будет установлен в 1. 

    4.4)Установить бит “ECanaRegs.CANTA.bit.TA5” в исходное со-

стояние: 
ECanaShadow.CANTA.all = 0; 

ECanaShadow.CANTA.bit.TA5 = 1; 

ECanaRegs.CANTA.all = ECanaShadow.CANTA.all; 

         5) Тестирование программы.  

         5.1) Сбросить ЦСП: Debug → Reset CPU, Debug → Restart. 

         5.2) Перейти к главной подпрограмме: Debug → Go main. 

         5.3) Запустить программу: Debug → Run.  

 

2. Настройка приема сообщения 

1) Создание нового проекта. 
1.1) В Code Composer Studio создать новый проект Lab10.pjt. 

Открыть файл Lab10.c и сохранить его в E:\C281x\Labs\Lab10\lab10.c.  
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1.2) Добавить в проект файлы: 

C:\tidcs\c28\dsp281x\v100\DSP281x_headers\source\DSP281x_GlobalVar

iableDefs.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_headers\source\DSP281x_GlobalVar

iableDefs.c 

C:\tidcs\c28\dsp281x\v100\DSP281x_headers\cmd\F2812_Headers_nonBI

OS.cmd 

C:\tidcs\c28\dsp281x\v100\DSP281x_common\cmd\F2812_EzDSP_RAM

_lnk.cmd 

C:\ti\c2000\cgtools\lib\ rts2800_ml.lib 

2) Настройка параметров проекта, компоновка проекта и загруз-
ка выходного файла. 

2.1) Включить в проект заголовочные файлы: Project →  Build 

Options, в закладке Compiler выбрать Preprocessor и в поле Include 

Search Path (-i) ввести:  

C:\tidcs\C28\dsp281x\v100\DSP281x_headers\include; ..\include 

 2.2) Задать глубину стека: Project → Build Options → Linker → 

Stack Size: 0x400. 

 2.3) Закрыть Build Options, кликнув OK. 

3) Преобразование файла Lab9.c. 

3.1) Открыть файл Lab10.c 

Удалить те части программы, которые не будут использоваться 

в данной лабораторной работе: подпрограмму “cpu_timer0_isr()”  и 

массив LED[8]. 

3.2)  Также от начала основной программы до цикла while(1) 

удалить все вызовы подпрограмм InitSystem( ) и GpioSelect( ).  

Задать новые инструкции для сторожевого таймера: 
EALLOW; 

SysCtrlRegs.WDKEY = 0x55; 

SysCtrlRegs.WDKEY = 0xAA; 

EDIS; 

3.3) Создать новую структуру в основной программе 
“ECanaShadow”: 

struct ECAN_REGS ECanaShadow; 

3.4) Перейти к подпрограмме «Gpio_select( )». Настроить пери-

ферийные функции CANTxA и CANRxA: 

GpioMuxRegs.GPFMUX.bit.CANTXA_GPIOF6 = 1; 

GpioMuxRegs.GPFMUX.bit.CANRXA_GPIOF7 = 1; 
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3.5) В конце кода программы создать подпрограмму InitCan( ), с 
помощью которой осуществить следующие шаги: 

3.5.1) В регистрах “ECanaRegs.CANTIOC” и “ECa-

naRegs.CANRIOC” установить биты “TXFUNC” и “RXFUNC”. 

3.5.2) Включить режим HECC модуля CAN (регистр 

“ECanaRegs.CANMC”). 

3.5.3) Для получения доступа к регистрам времени установить 

бит “CCR” регистра “ECanaRegs.CANMC”. 

3.5.4) Для передачи запроса инициализации CAN установить 

флаг “CCE” регистра “ECanaRegs.CANES”. 

3.5.5) Установить параметры “BRP”, “TSEG1” и “TSEG2” реги-

стра “ECanaRegs.CANBTC”. 

3.5.6) После установления параметров  регистра 
“ECanaRegs.CANBTC” запретить к нему доступ - очистить бит CCR 

регистра “ECanaRegs.CANMC”.  

3.5.7) Отключить все mailboxes кроме того, который отправляет 
сообщение, установкой в  0 полей регистра “ECanaRegs.CANME”. 

3.6)  Для подготовки mailbox#1 к приему сообщения сделать 

следующее: 
3.6.1) Установить идентификатор сообщения 0x10000000 (бит 

“IDE” регистра “EcanaMboxes.MBOX1.MSGID”). 

3.6.2)  Для установления mailbox#1 принимающим установить 

бит “MD1” регистра “ECanaRegs.CANMD”. Используя буферные ре-
гистры «ECanaShadow.CANMD.all» осуществить запись в регистр 

“ECanaRegs.CANMD”: 

ECanaShadow.CANMD.all = ECanaRegs.CANMD.all; 

ECanaShadow.CANMD.bit.MD1 = 1; 

ECanaRegs.CANMD.all = ECanaShadow.CANMD.all; 

Активировать mailbox#5: 

ECanaShadow.CANME.all = ECanaRegs.CANME.all; 

ECanaShadow.CANME.bit.ME1 = 1; 

ECanaRegs.CANME.all = ECanaShadow.CANME.all; 

4) Организация цикла опроса mailbox#1 

4.1) Организовать цикл опроса и приема сообщения. Когда со-

общение придет,  бит “RMP1” регистра “ECanaRegs.CANRMP” станет 
равным 1.   

С помощью цикла do-while организовать ожидание RMP1=1.  

Примечание 1. Рекомендуется скопировать регистры 

“ECanaRegs.CANRMP”  в буферные “ECanaShadow.CANRMP”. 
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Примечание 2. В цикле ожидания не забывать активировать стороже-
вой таймер. 

          4.2) Как только бит RMP1 станет равным 1следует отправить 

нулевой байт на порты GPIO-B7…B0: 

GpioDataRegs.GPBDAT.all = ECanaMboxes.MBOX1.MDL.byte.BYTE0; 

          4.3) Сбросить бит RMP1, записав в него «1»: 

ECanaShadow.CANRMP.bit.RMP1 = 1; 

ECanaRegs.CANRMP.all = ECanaShadow.CANRMP.all; 

5) Тестирование программы.  

5.1) Сбросить ЦСП: Debug → Reset CPU, Debug → Restart. 

 5.2) Перейти к главной подпрограмме: Debug → Go main. 

5.3) Запустить программу: Debug → Run. [6] 

 

 

3. Инициализация нового узла в сети CAN 

 

Для правильного приема/передачи сообщения необходимо сна-
чала запустить программу приема узлом сообщения л/p 10 (узел от-
правляет на шину сигнал о своем присутствии), и только затем запус-
тить программу передачи сообщения л/р 9. При подключении к сети 

нового принимающего узла необходимо до подключения перевести в 

режим останова передающий узел. После подключения нового при-

нимающего узла запустить программу приема  (л/р 10), и только по-

том произвести перезапуск передающего узла (л/р 9). 
 

Листинг передачи сообщения 

 

// FILE: Lab9.c 

// TITLE:DSP28 CAN Передача  
//CPU Timer0 ISR каждые 50 мс 
//Watchdog активен, работает в ISR и в главном цикле 
//CAN-сообщение: 1 Байт (состояние GPIO B15-B8) каждую 1 секунду 

//   Скорость 100KBPS 

//   Идентификатор :  0x1000 0000 

//   Mailbox #5   

#include "DSP281x_Device.h"   // Включение заголовочного файла  
 

void Gpio_select(void); 

void SpeedUpRevA(void); 
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void InitSystem(void);   

void InitCan(); 

interrupt void cpu_timer0_isr(void); 

// Программа обработки прерывания Timer 0  

 

void main(void) 

{ 

struct ECAN_REGS ECanaShadow; 

  

InitSystem();  // Инициализация регистров ЦСП 

  

Gpio_select();  // Инициализация линий ввода/вывода  
InitPieCtrl();// Подключение PIE-модуля (DSP281x_PieCtrl.c) 

  

InitPieVectTable(); // Подключение PIE-вектора (DSP281x_PieVect.c ) 

  

// отобразим PIE – вход для таймера прерываний Timer 0 

EALLOW;  // Необходимо для записи EALLOW в защищенные реги-

стры 

   PieVectTable.TINT0 = &cpu_timer0_isr; 

   EDIS;    // Необходимо для отмены записи EALLOW в защищенные 
регистры 

  

InitCpuTimers(); 

  

// Настроить CPU-Timer 0 на прерывание каждые 50 мс: 
// 150MHz частота CPU, период прерывания 50000 мкс 
    ConfigCpuTimer(&CpuTimer0, 150, 50000); 

     

    // Допуск TINT0 в PIE: Группа 1 прерывание 7 

   PieCtrlRegs.PIEIER1.bit.INTx7 = 1; 

 

// Допуск CPU к INT1 связанному с CPU-Timer 0: 

    IER = 1; 

     

// Разрешение глобальным прерываниям и более приоритетным собы-

тиям отладки в реальном времени: 

   EINT;   // Разрешение глобального прерывания INTM 
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   ERTM;   // Разрешение глобального прерывания в реальном времени 

DBGM 

      

   InitCan(); 

     /* Запись в поле MSGID */ 

    ECanaMboxes.MBOX5.MSGID.all     = 0x????????;  

  ECanaMboxes.MBOX5.MSGID.bit.IDE = ?;  // Установка идентифика-
тора сообщения 

 

 /* Установка Mailbox 5 передающим */ 

ECanaShadow.CANMD.all = ECanaRegs.CANMD.all;  

ECanaShadow.CANMD.bit.MD5 = ?; 

ECanaRegs.CANMD.all = ECanaShadow.CANMD.all;  

/* Активация Mailbox 5 */ 

ECanaShadow.CANME.all = ECanaRegs.CANME.all;  

ECanaShadow.CANME.bit.ME5 = ?; 

ECanaRegs.CANME.all = ECanaShadow.CANME.all;  

  

/* Установка длины сообщения равной 1 */ 

ECanaMboxes.MBOX5.MSGCTRL.bit.DLC = ?;   

CpuTimer0Regs.TCR.bit.TSS = 0; 

  while(1) 

{     

  while(CpuTimer0.InterruptCount < 20) 

{    // ожидание Timer 0 

    EALLOW; 

    SysCtrlRegs.WDKEY = 0xAA;  // и передача watchdog #2 

  

    EDIS; 

} 

CpuTimer0.InterruptCount = 0;  // обнулить таймер прерываний 

    ECanaMboxes.MBOX5.MDL.byte.BYTE0 = (GpioDa-

taRegs.GPBDAT.all>>8 ) ; 

     ECanaShadow.CANTRS.all = ?;   

     ECanaShadow.CANTRS.bit.TRS5 = ?;     // Посыл запроса передачи 

Mailbox 5  

     ECanaRegs.CANTRS.all = ECanaShadow.CANTRS.all;  
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     while(ECanaRegs.CANTA.bit.TA5 == 0 ) {}  // Когда бит TA5 уста-
новлен.. 

      

     ECanaShadow.CANTA.all = ?;   

     ECanaShadow.CANTA.bit.TA5 = ?;       // Установка бита TA5 в 

исходное состояние        
     ECanaRegs.CANTA.all = ECanaShadow.CANTA.all; 

 } 

}   

 

void Gpio_select(void) 

{ 

    EALLOW; 

    GpioMuxRegs.GPAMUX.all = 0x?; // Настройка линий вво-

да/вывода на работу в качестве портов 

    GpioMuxRegs.GPBMUX.all = 0x?;    

    GpioMuxRegs.GPDMUX.all = 0x?; 

    GpioMuxRegs.GPFMUX.all = 0x?;  

    GpioMuxRegs.GPFMUX.bit.CANTXA_GPIOF6 = ?;    // Настройка 
периферийных функций CANTXA и  

    GpioMuxRegs.GPFMUX.bit.CANRXA_GPIOF7 = ?;  // CANRXA 

для работы с CAN-модулем  

    GpioMuxRegs.GPEMUX.all = 0x?;  

    GpioMuxRegs.GPGMUX.all = 0x?;    

    GpioMuxRegs.GPADIR.all = 0x?; // Настройка портов А, D, E, F, 

G на ввод  

    GpioMuxRegs.GPBDIR.all = 0x????;  // Настройка линий 15-8 на 
ввод, а линий 7-0 на вывод 

    GpioMuxRegs.GPDDIR.all = 0x?;  

    GpioMuxRegs.GPEDIR.all = 0x?;  

    GpioMuxRegs.GPFDIR.all = 0x?;  

    GpioMuxRegs.GPGDIR.all = 0x?;  

 

    GpioMuxRegs.GPAQUAL.all = 0x?; // Запрещение входного огра-
ничителя 

    GpioMuxRegs.GPBQUAL.all = 0x?; 

    GpioMuxRegs.GPDQUAL.all = 0x?; 

    GpioMuxRegs.GPEQUAL.all = 0x?; 

    EDIS; 
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}      

 

void InitSystem(void) 

{ 

   EALLOW; 

    SysCtrlRegs.WDCR= 0x00AF;  // Работа сторожевого таймера  
     // 0x00E8  запрещение работы  сторожевого таймера, преддели-

тель = 1 

     // 0x00AF  Разрешение работы сторожевого таймера, предделитель 

= 64 

   SysCtrlRegs.SCSR = 0;    // Выработка сброса WDT  

   SysCtrlRegs.PLLCR.bit.DIV = 10; // Настройка блока умножения 

частоты 

   SysCtrlRegs.HISPCP.all = 0x1; // Задание значения предделителя вы-

сокоскоростного таймера 
  SysCtrlRegs.LOSPCP.all = 0x2; // Задание значения предделителя 

низкоскоростного таймера 
     // Запрещение работы периферийных устройств кроме eCAN    

    SysCtrlRegs.PCLKCR.bit.EVAENCLK=0; 

    SysCtrlRegs.PCLKCR.bit.EVBENCLK=0; 

    SysCtrlRegs.PCLKCR.bit.SCIAENCLK=0; 

    SysCtrlRegs.PCLKCR.bit.SCIBENCLK=0; 

    SysCtrlRegs.PCLKCR.bit.MCBSPENCLK=0; 

    SysCtrlRegs.PCLKCR.bit.SPIENCLK=0; 

    SysCtrlRegs.PCLKCR.bit.ECANENCLK=1; 

    SysCtrlRegs.PCLKCR.bit.ADCENCLK=0; 

    EDIS; 

} 

interrupt void cpu_timer0_isr(void) 

{ 

      CpuTimer0.InterruptCount++;  // Сообщение watchdog-таймеру о 

каждом прерывании Timer 0  

     EALLOW; 

    SysCtrlRegs.WDKEY = 0x55;  // Сообщение таймеру watchdog 

#1 

   EDIS; 

   // Это прерывание произошло от прерываний группы 1 

   PieCtrlRegs.PIEACK.all = PIEACK_GROUP1; 

}             
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void InitCan(void) 

{ 

   asm("  EALLOW"); 

/* Настроить линии TX и RX на передачу используя регистры eCAN*/   

    ECanaRegs.CANTIOC.bit.TXFUNC = ?; 

    ECanaRegs.CANRIOC.bit.RXFUNC = ?;    

/* Настроить eCAN на режим HECC - (доступ к чтению mailboxes 16 - 

31) */  

// В режиме HECC разрешена особенность временного ограничения 

ECanaRegs.CANMC.bit.SCB = ?;    

/* Настроить параметры тактовой синхронизации */ 

ECanaRegs.CANMC.bit.CCR = ? ;            // Установка CCR для получе-
ния доступа к регистрам времени 

  while(ECanaRegs.CANES.bit.CCE != 1 ) {}   // Когда ССЕ (флаг для 

передачи запроса инициализации CAN)установлен.. 

    ECanaRegs.CANBTC.bit.BRPREG = ??;     // Установка параметров 

BRP,TSEG1 и TSEG2 

    ECanaRegs.CANBTC.bit.TSEG2REG = ?;    // таким образом, чтобы 

скорость передачи 

    ECanaRegs.CANBTC.bit.TSEG1REG = ??;   // была 100кбит/с 
     

    ECanaRegs.CANMC.bit.CCR = ? ;             // Сброс CCR регистра 
CANMC для запрета доступа к регистру CANBTC 

    while(ECanaRegs.CANES.bit.CCE == !0 ) {}   // Когда CCE сбро-

шен.. 

} 

/* Отключить все Mailboxes  */ 

//================================================= 

// Конец программы. 

//================================================= 

 

Листинг приема сообщения 

 

// FILE: Lab10.c 

// TITLE: DSP28 CAN Прием ,  Mailbox 1 

//Идентификатор 0x10 000 000 ; Скорость 100 KBPS    

//Байт данных 1 из CAN – кадр будет скопирован из 8 LED's (GPIOB7 

- B0) 

// Watchdog активен, работает в ISR и в главном цикле 
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#include "DSP281x_Device.h"  // Включение заголовочного файла 
 

void Gpio_select(void); 

void InitSystem(void);      

void InitCan(void); 

 

void main(void) 

 

{ 

struct ECAN_REGS ECanaShadow; 

  

InitSystem();  // Инициализация регистров ЦСП 

Gpio_select();  // Инициализация линий ввода/вывода      
InitCan(); 

  

/* Запись в поле MSGID - MBX номер записан как его MSGID */ 

   ECanaMboxes.MBOX1.MSGID.all  = 0x????????;  // Установка иден-

тификатора сообщения  

   ECanaMboxes.MBOX1.MSGID.bit.IDE = ?;    

     

/* Установка Mailbox 1 принимающим */ 

ECanaShadow.CANMD.all = ECanaRegs.CANMD.all;  

ECanaShadow.CANMD.bit.MD1 = ?; 

ECanaRegs.CANMD.all = ECanaShadow.CANMD.all;  

 

/* Активация Mailbox 1 */ 

ECanaShadow.CANME.all = ECanaRegs.CANME.all;  

ECanaShadow.CANME.bit.ME1 = ?; 

ECanaRegs.CANME.all = ECanaShadow.CANME.all;      

while(1) 

{     

    do  

    { 

     ECanaShadow.CANRMP.all = ECanaRegs.CANRMP.all;  

EALLOW; 

    SysCtrlRegs.WDKEY = 0x55;       //  Сообщение таймеру watchdog #1 

    SysCtrlRegs.WDKEY = 0xAA;  //  Сообщение таймеру watchdog #2
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EDIS; 

    }    

  while(ECanaShadow.CANRMP.bit.RMP1 != 1 );       // Когда RMP1 ус-
тановлен.. 

         

     GpioDataRegs.GPBDAT.all = ECanaM-

boxes.MBOX1.MDL.byte.BYTE0; 

 ECanaShadow.CANRMP.bit.RMP1 = ?; 

ECanaRegs.CANRMP.all = ECanaShadow.CANRMP.all;     

// Clear RMP1 bit and start again 

 } 

}   

 

void Gpio_select(void) 

{ 

EALLOW; 

GpioMuxRegs.GPAMUX.all = 0x?; // Настройка линий вво-

да/вывода на работу в качестве портов 

    GpioMuxRegs.GPBMUX.all = 0x?;    

    GpioMuxRegs.GPDMUX.all = 0x?; 

    GpioMuxRegs.GPFMUX.all = 0x?;    

    GpioMuxRegs.GPEMUX.all = 0x?;  

    GpioMuxRegs.GPGMUX.all = 0x?; 

    GpioMuxRegs.GPFMUX.bit.CANTXA_GPIOF6 = ?;  // Настройка 
периферийных функций CANTхA и CANRхA 

    GpioMuxRegs.GPFMUX.bit.CANRXA_GPIOF7 = ?;   

  

          

    GpioMuxRegs.GPADIR.all = 0x?; // Настройка портов А, D, E, F, 

G на ввод 

    GpioMuxRegs.GPBDIR.all = 0x????; // Настройка линий 15-8 на 
ввод, а линий 7-0 на вывод  

    GpioMuxRegs.GPDDIR.all = 0x?;  

    GpioMuxRegs.GPEDIR.all = 0x?;  

    GpioMuxRegs.GPFDIR.all = 0x?;  

    GpioMuxRegs.GPGDIR.all = 0x?;  

 

    GpioMuxRegs.GPAQUAL.all = 0x?;  // Запрещение входного огра-
ничителя 
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    GpioMuxRegs.GPBQUAL.all = 0x?; 

    GpioMuxRegs.GPDQUAL.all = 0x?; 

    GpioMuxRegs.GPEQUAL.all = 0x?; 

    EDIS; 

}      

 

void InitSystem(void) 

{ 

   EALLOW; 

   SysCtrlRegs.WDCR= 0x00AF;  // Работа сторожевого таймера  
    // 0x00E8  запрещение работы  сторожевого таймера, преддели-

тель = 1 

    // 0x00AF  Разрешение работы сторожевого таймера, предделитель 

= 64 

 

   SysCtrlRegs.SCSR = 0;    // Выработка сброса WDT 

  

   SysCtrlRegs.PLLCR.bit.DIV = 10; // Настройка блока умножения 

частоты 

   SysCtrlRegs.HISPCP.all = 0x1; // Задание значения предделителя вы-

сокоскоростного таймера 
  SysCtrlRegs.LOSPCP.all = 0x2;  // Задание значения предделителя 

низкоскоростного таймера 
        

   // Запрещение работы периферийных устройств кроме еСAN    

    SysCtrlRegs.PCLKCR.bit.EVAENCLK=0; 

    SysCtrlRegs.PCLKCR.bit.EVBENCLK=0; 

    SysCtrlRegs.PCLKCR.bit.SCIAENCLK=0; 

    SysCtrlRegs.PCLKCR.bit.SCIBENCLK=0; 

    SysCtrlRegs.PCLKCR.bit.MCBSPENCLK=0; 

    SysCtrlRegs.PCLKCR.bit.SPIENCLK=0; 

    SysCtrlRegs.PCLKCR.bit.ECANENCLK=1; 

   SysCtrlRegs.PCLKCR.bit.ADCENCLK=0; 

   EDIS; 

}   

void InitCan(void) 

{ 

asm("  EALLOW"); 

/* Настроить линии TX и RX на передачу используя регистры eCAN*/   
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    ECanaRegs.CANTIOC.bit.TXFUNC = ?; 

    ECanaRegs.CANRIOC.bit.RXFUNC = ?;    

 

/* Настроить eCAN на режим HECC - (доступ к чтению mailboxes 16 - 

31) */  

// В режиме HECC разрешена особенность временного ограничения 

ECanaRegs.CANMC.bit.SCB = ?;     

 

/* Настроить параметры тактовой синхронизации */ 

ECanaRegs.CANMC.bit.CCR = ? ;         // Установка CCR для получе-
ния доступа к регистрам времени 

    while(ECanaRegs.CANES.bit.CCE != 1 ) {}   // Когда CCE (флаг для 

передачи запроса инициализации CAN) установлен..  

    ECanaRegs.CANBTC.bit.BRPREG = ??; 

    ECanaRegs.CANBTC.bit.TSEG2REG = ?; 

    ECanaRegs.CANBTC.bit.TSEG1REG = ??;   

     

    ECanaRegs.CANMC.bit.CCR = ? ;             // Сброс бита CCR регист-
ра CANMС для запрета доступа к регистру CANBTC 

    while(ECanaRegs.CANES.bit.CCE == !0 ) {}   // Когда CCE сбро-

шен.. 

 

/* Отключить все Mailboxes  */ 

  

 ECanaRegs.CANME.all = ?;   // Отключить все Mailboxеs кроме того 

который отправляет сообщение 
asm("  EDIS"); 

}    

//====================================================  

// Конец программы. 

//==================================================== 

 

 

 

Содержание отчета: 

 

Отчет должен содерж ать цель работы, краткие теоретические 
сведения по теме работы, рисунки, тексты исследуемых программ пе-
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редачи и приема данных через CAN-интерфейс, результаты их вы-

полнения, выводы. 

 

Контрольные вопросы: 

 

1. Особенности CAN-интерфейса DSP TMS320F2812. 

2. Модуль и сеть CAN. 

3. Протоколы CAN. 

4. Контроллеры еCAN. 

5. Карта памяти еCAN. 

6. Регистры управления и состояния eCAN. 

7. Использование Mailbox для приема и передачи сообщений. 
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